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Abstrakt

Pro zkoumání vlastností systémů nebo procesů jsou simulace stěžejním matematickým

nástrojem. V letectví se – stejně jako v jiných oblastech průmyslu – podílejí například

na jeho zefektivnění nebo bezpečnosti. Tato práce se zabývá simulátorem řízení letového

provozu, který byl vyvinut přední evropskou institucí z oboru, a jeho konceptem využití

na Ústavu letecké dopravy. Přestože se jedná o velmi kvalitní nástroj, nebyl původně

zamýšlen pro použití čistě v univerzitním prostředí. Proto se v tomto směru autor zabývá

určitými limitacemi a představuje specifický přístup k simulátoru jak v rámci výuky, tak

i ve vědě a výzkumu. Čerpá přitom ze svých zkušeností se simulátorem, které – spolu

s potřebami vyučujících Ústavu a jeho vědeckých pracovníků – vytváří celkový koncept

využití. Na tom je založený hlavní výstup práce, kterým je náčrt a popis možných bu-

doucích projektů a akcích potřebných k jejich naplnění.

Klíčová slova: simulátor, simulace, řízení letového provozu, řídící, letecký provoz, návod,

implementace, výuka, výzkum
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Abstract

Simulations represent a pivotal element of mathematical studying of processes or products.

As well as in other industry branches, simulations help making aviation more streamlined,

efficient, and safe. The thesis aims to propose deployment methods for industry-developed

air traffic control simulator to university environment. Despite being a powerful tool, it

was not initially made for university use. Hence, the author deals with some of its limita-

tions in this regard and lays out a specific approach for the future successful deployment

of the simulator at the Department of Air Transport at Czech Technical University. Ac-

cording to author’s previous experience and overall usage of the simulator, the concept of

deployment is developed upon Department’s educational, and science and research needs.

Based on acquired prowess at simulation exercise creation in the software, a brief outline

of the most important actions for future users is provided.

Keywords: simulator, simulations, air traffic control, air traffic control officer, air traffic,

guide, deployment, education, research
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Introduction

The CNS/ATM Laboratory at Czech Technical University in Prague is one of research

laboratories of the Department of Air Transport (DoAT). In the past years, the main

activities of the laboratory focused primarily on the field of Communications Navigation

Surveillance. In the recent time, the laboratory’s major science and research topics have

focused on Global Navigation Satellite System (GNSS) signal interference or Multilatera-

tion (MLAT) systems. There are also many laboratory-owned ADS-B receivers positioned

across the Czech Republic that are used for carrying out experiments. These topics have

served as a foundation for numerous bachelor’s and master’s theses as well as science and

research works and articles.

Meanwhile, the Air Traffic Management sphere of the laboratory has been sidelined.

Therefore, it is a necessity that the two sectors are more balanced, not only in the science

and research domain but also in education. In order to support this initiative, implement-

ing a useful simulation tool that is going to be highly modern, modular, and customizable

enough to satisfy the needs of all upcoming projects (for students, teachers and experts)

was needed. That is where a versatile ATC simulator comes forward.

Simulations started to occur since the computer industry accelerated its expansion at the

end of the last millennium. Nowadays, simulations are being applied across numerous

fields. According to the Oxford Dictionary, simulation is a situation where – after defin-

ing a particular set of variables and conditions – one can study and observe something

that could or is about to exist in reality.[1] The variables and conditions deeply depend

on topics ranging from economics and human systems to engineering and video games.

Carrying out a simulation enables to validate situations that could occur in the future.

If the simulation outcome meets the expectations, it is generally safe to proceed with the

same scenario in real operations. If the simulation outcome does not comply with the

desired requirements, the path should be avoided, or the simulation should be carried
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out with a different set of variables and conditions. This knowledge often saves invested

assets, which could be lost by not anticipating or underestimating the coming situation.

Concerning air traffic control, the invested assets do not only include money, but also

people’s lives. Therefore, it is essential to emphasize carrying out simulations in this

field. One of the reasons air traffic is simulated is to train future air traffic controllers.

The main advantage and purpose of simulation during air traffic control officers (ATCO)

training is to introduce ATCOs to their future work environment as soon as possible.

According to the Commission Regulation (EU) 2015/340, ‘air traffic controller training

shall cover the entirety of theoretical courses, practical exercises, including simulation,

and on-the-job training required in order to acquire and maintain the skills to deliver safe,

orderly and expeditious air traffic control services.’.[2] The training architecture generally

includes special didactic tools like the ability to start/stop the simulation or replay the

sound recordings, which helps assess the trainee more efficiently. Later in the training,

both standard and non-standard situations are carried out in the simulator, or the traffic

flow is adjusted to match ATCO’s current skills and experience.

The other main reason air traffic is simulated is to optimize the airspace and its traffic

flow. During normal operations in Europe, the airways are congested and airspace reaches

its capacity limits in numerous areas across the EU. Therefore, reducing the bottlenecks

is desirable. Finding and eliminating inefficiencies in these fields can be achieved by in-

novative simulations. Similarly, short-term rise of demand due to the Olympic Games,

World Championships or Expo events cannot stay unnoticed. If needed, the traffic flows

will have to be reorganized, or the capacity increased before these events occur in their

respective locations. Again, simulations may be carried out with increased traffic flow

parameters to assess the risk of not meeting the demand.

A slightly different use case can be observed in the academic sphere. While proving sci-

entific hypotheses, researchers often test the infrastructure limits by simulating complex

resource-demanding fictional scenarios. Scientists’ field of interest may include air traffic

services (ATS) efficiency assessment or integrating urban air mobility (UAM) within the

16
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airspace. Educators and academics focus on introducing interactive means of teaching

and improving the overall quality of education. Students are able to get fundamental

practical knowledge by working with the simulator. That is why, in 2019, the DoAT

decided to take action and invest resources into a simulation tool that would improve the

ATM education, science and research part of the CNS/ATM Laboratory there.

In this master’s thesis, the author will introduce several means of simulation of air traffic

control and management, primarily focusing on air traffic control simulator called ES-

CAPE Light developed by Eurocontrol Experimental Centre. Prior to writing this thesis,

the author spent a significant amount of time working with the simulator since the first

contact between the ESCAPE simulator and the Department of Air Transport. The

software, not primarily intended for use at universities, had to be understood, correctly

installed and adjusted to the Department’s needs. The thesis as a whole focuses on the

simulator’s application and wider deployment at the Department of Air Transport at the

Faculty of Transportation Sciences of Czech Technical University in Prague. The cur-

rent state of the simulator, its functions, and the exercises created and used will also be

discussed. The output of the thesis is to explain the fundamental issues of creating a simu-

lation exercise in the university environment, provide some basic guidelines for designing

an exercise, describe currently used features and functions. Mainly it will introduce a

vision for an application of the simulator for education, science, and research. The vision

is based on the analysis conducted in cooperation with the Department of Air Transport

laboratories inquiring about the future interest of including the ATC simulator in their

research portfolio. In the appendix, a reader (future user) will be provided with some of

basic procedures for controlling the simulator that serve as a user’s guide.

17
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1 Aviation Simulations

Although the Covid-19 crisis stopped the ongoing expansion of aviation, it is neverthe-

less a dynamically changing and evolving industry. It has been immensely developed

and standardised worldwide for over a hundred years since the first crewed flight. Flight

tickets are now much cheaper than a hundred years ago, and flying is generally more avail-

able for everyone. This whole magnification can be partially attributed to simulations.

They have helped manufacturers streamline their production processes, contributed to im-

proved training of flight crews and operational personnel, and were deployed to optimise

the airspace throughput and correctly distribute the workload of air traffic controllers.

Finally, modelling busy airways, airports, and heliports should also be mentioned, as it

helped to accommodate and service as many aircraft as possible at the same time.

By looking at the current competing aviation market, it is evident that all stakeholders are

trying their best to succeed among the most modern inventions and strategies. To fine-

tune it even more, the deployment of simulations has to be ongoing. In the subchapters

below, the most notable kinds of simulations are introduced and described.

1.1 Computational Fluid Dynamics

One of the first means of simulation in the aviation industry has been derived from testing

small-scale airfoil models in a wind tunnel. Back in 1915, National Advisory Committee

for Aeronautics (NACA) was founded, and it was the start of the most progressive in-

stitution in this field and aerospace in general. Before its incorporation in the National

Aeronautics and Space Administration (NASA) in 1958, it had been able to test and de-

fine 78 airfoil shapes, many of which were used in past aircraft (for example, many World

War II planes). After that, many contemporary designs have their source in the original

four-digit numbered NACA airfoils.[3]

Nowadays, it is undoubtedly easier to simulate computational fluid dynamics (CFD) by

computers. That helps modern aircraft to save fuel because designing even more efficient

wing and aerodynamic shape of the fuselage is a difficult task these days. Simulating the
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airflow with the help of a computer can still lower the drag coefficient or increase the lift

one. It is also useful to predict overall wing dynamics and flutter by this method to make

it safe to fly.[4]

1.2 Flight Simulation

Flight simulators are probably the most advanced kind of aviation simulation. Initially

used only as a training aid for future pilots, the concept has gone a long way since then.

Professional flight simulators are generally expensive and exceptional machines located

in most airlines’ training centres certified for official pilot training on a specific aircraft

type. They are usually built as a cockpit imitation standing on hydraulic pistons. The

pistons are there to simulate the movement of an aircraft. The cabin is a precise copy

of the real cockpit, usually not much simplified, because it needs to deliver as realistic

experience as possible. It is also beneficial for simulating full-scale faults or emergency

situations without endangering the crew or passengers.

The cockpit can also be built unprofessionally – without contracting a certified supplier.

The purpose is then to mimic the real cockpit as much as possible without inducing high

costs. Sometimes, genuine aircraft cabin parts are sold on the internet, but the prices

are generally not affordable and worth implementing into a simulator. In conclusion, the

majority of those simulators are built in-house. That does not decrease the quality of the

simulator, but it rather saves costs. However, all the deviations from the original aircraft

shall be addressed. What usually connects the professional and unprofessional simulators

is the software. There are a number of reliable simulation software platforms that are

incredibly real-like and high quality. The most famous ones are Microsoft Flight Simu-

lator and Prepar3D, or Laminar Research X-Plane that is widely used on a professional

level, too.[5] The differences between those three are minimal and depend upon individual

specific requirements.

All these highly developed software simulators deliver an immense amount of features use-

ful in relation to physical simulators. If the physical simulator and software are thought-
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fully and elaborately connected and set up, it can serve as a fully-fledged flight simulator

able to be certified. That is needed for the airline to train professional pilots.

Nowadays, virtual reality (VR) is emerging as one of the key interfaces and means of

controlling the simulator. The expensive cockpit hardware can then be more or less omit-

ted because it is supposed to be modelled inside of the VR environment. However, even

more pressure is put on precisely functioning software afterwards. The biggest problem is

designing and creating inputs into the simulator as you need a physical switch or button

to interact with. This is frequently dealt with by including special VR gloves sensed by

the virtual reality hardware, transmitting the position and state of the human’s hand into

the simulator’s interface.

1.3 Aerodrome Simulation

What matters the most in terms of aerodrome simulation is the capacity. Whether the

airports as a whole or just parts like runways, taxiways, and aprons are concerned, their

capacity states how many aeroplanes – or generally speaking movements (MVTs) – is the

infrastructure able to take in a given amount of time. Simulating airport operations aims

to find bottlenecks in various parts of the infrastructure, which are then to be assessed

and the traffic reorganised if needed. The most desired output of all this is to reduce

delays while sustaining traffic growth and, therefore, additional revenue generation.

Runway capacity calculations are a common model of aerodrome simulation. It is also

the easiest use case to simulate. That is mainly thanks to the overall similarity of all

the world’s runways. By definition, runway (RWY) is ‘a defined rectangular area on a

land aerodrome prepared for the landing and take-off of aircraft’ [6]. That makes every

runway in the world similar. The only variables that need to be defined for each runway

include[7]:
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• basic parameters of RWY (width, length, declared distances, kind of pavement, ...),

• current parameters of RWY (contamination, visibility and weather conditions, day/night,

mode of use, ...),

• parameters of approach for current RWY (category of approach – instrumentation

used, angle of descent, speeds, ...),

• exit points of RWY (number of RETs – Rapid Exit Taxiways, TWYs – taxiways,

...).

The aircraft are also standardised, so either the particular models (ICAO or IATA defined)

or approach categories (either ICAO or FAA defined) can be used to feed the model. Af-

ter defining those parameters, one can reliably compute the estimate of runway capacity

with a help from a basic model that counts with above-mentioned parameters and wake

turbulence separation.

However, taxiways and aprons are more complicated elements to calculate. Because of

their complexity and the fact that each airport has a different set of pavements, cross-

ings, apron stands, and de-icing stands, these capacity figures need to be simulated with

dedicated simulation software. For example, aircraft stand and gate allocation problem

is frequently dealt with.

But not only the airside is subject to simulations. In the landside, simulation of processes

inside of a terminal is also critical. One of the examples is simulating the flow of passengers

travelling from the airport entrance to a gate. It includes all the single stops passengers

has to undergo. These flows are mainly simulated for getting data of how long before

their respective flights do passengers arrive at an airport. Another example is to simulate

most optimal path for the flows of the passengers.

For precise airport simulation and overview, one can also simulate landside vehicles move-

ment (like parking spots occupation time or density of traffic on adjacent roads), ground

handling (the movement, traffic and occupancy time of individual service vehicles, bag-

gage handling system) or airport facilities needs. The often mentioned parameters of
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airports are the level of service (LoS) – that has to be maximised while maintaining a

reasonable cost – and ever-present delay – that has to be minimised, of course. One of

the simulation tools that can help with all these scopes mentioned, is CAST software,

developed by the Airport Research Center (ARC) in Germany.[9]

1.4 Air Traffic Control and Management Simulations

The Air Traffic Control and Management simulations are at the centre of attention of

this thesis. For a start, it should be elaborated why there is a need for air traffic control

and management simulations. As said in the introduction, there are many reasons for

simulating air traffic management (ATM) processes. The author has focused on those

listed below.

In general, the main purpose of simulation is to design exercises, test procedures and

processes, and evaluate the results while striving to obtain maximum efficiency. Also,

the training of ATCOs should be enhanced utilizing reality-like environment. Note that

sometimes the air traffic control and management simulations can overlap with airport

simulations.

• Airspace operations:

– airspace design (change in an airway or flightpath, sectorization, UAV (Un-

manned Aerial Vehicle) integration, etc.),

– optimization of processes (also airports – in order to increase capacity, reduce

delays, etc.),

– new tools, systems, procedures, products development, or

– managerial tool to evaluate various scenarios, later applied in operations.

• Training:

– training of (student) air traffic controllers (ATCOs),

– continuation training – revalidation of already licensed ATCOs or conversion

training,
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– development training – extending license of already licensed ATCOs (to be an

emergency trainer, assessor, supervisor, ...)

– education of Air Transport students or pilots for getting cognizance of ATCOs’

job.

• Specific Training (does not regularly occur during OJT):[10]

– unusual procedures (flight testing, military activity, e.g. parade or quick relo-

cation),

– seasonal traffic procedures (summer vacations, ski season, Hajj flights1)

– irregular complex traffic situations or procedures (air shows etc.);

• Research and development:

– e.g. proposing and validating new concepts and products for implementing

into airspace operations.

Generally, according to IATA (International Air Transport Association)[11], the airspace

optimization process has five phases: diagnostic, planning, development, training, and

implementation. Simulator tools are a pivotal part of this process, mainly in the diag-

nostic and training phases. Firstly, from the air traffic control and management view,

any planned change in the existing airspace design shall be simulated to error-proof the

concept and find bottlenecks, shortcomings, or inefficiencies. That does not mean simu-

lations are not used in the planning phase, too.

If the sectorization is about to be different, it might be useful to simulate it with the AT-

COs that hold the license at the respective airspace. Similarly, if available, ATCOs can

help assess any change to infrastructure and particular simulation exercises because, after

all, they are controlling the airspace subsequently. Simulations can also be helpful in the

future after the UAV integration into airspace takes place and proper legislation is applied.

1author’s remark: flights that carry pilgrims to Mecca, the holy city for Muslims
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Regarding the training, the requirements for ATCO training are defined by the most

recognisable institutions – the International Civil Aviation Organization (ICAO) and the

European Aviation Safety Agency (EASA). According to ICAO[10], the competency-based

training of ATCOs is structured into three phases (can be seen in the picture 1.1), EASA’s

approach is very similar. In fact, the basic and the most important document of Euro-

pean legislation in this regard is the Commision Regulation (EU) 2015/340[2], from which

EASA created so-called Easy Access Rules for ATCO Licensing and Certification[12] – for

delivering accessible and efficient way to introduce this problematic to EASA stakeholders.

Figure 1.1: Phases of ATCO Competency-Based Training by ICAO (courtesy of [13],

reworked)

During the Initial Training, the trainee will learn the fundamental basic skills and knowl-

edge to initiate the specialised part of training. After succesful completion of the initial

training, the trainee will become a student ATCO with an appropriate license. After-

wards, in the Unit Training, the simulator part comes forward. In order to acquire the

official ATCO license, the student ATCO has to undergo three phases of Unit Training

listed below, in which he or she will get a site-specific insight into the job:
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• Transitional training (transition from the Initial Training into the site-specific the-

oretical knowledge);

• Pre-OJT (On-the-Job Training) – more site-specific training strengthening trainee’s

previously acquired abilities, locally based training;

• OJT (done under qualified OJT supervision, putting previously acquired skills into

practice, live traffic situations).

Site-specific simulations occur in the first two phases of the Unit Training. The site and

the form of simulations depend on the desired rating (aerodrome control, approach con-

trol, area control, approach precision radar control, ...). After completing these phases,

the ATCO becomes certified personnel. Next, there is Continuation Training, where the

knowledge and skills of the personnel are refreshed or updated. Emergency training is also

a fundamental part of ATCO training, where the personnel uses their knowledge in an

emergency, unusual or non-standard (degraded) situation. This kind of training is benefi-

cial because merely simulated emergency situations don’t endanger any people or assets.

For example, aircraft technical issue or a hijack situation is trained. ATCOs can also be

conversed to a different job category or re-trained when there is a change in a procedure

or system (this is called Conversion Training). There, the Continuation Training takes

place, too.[14]

Lastly, there is Development Training, intended for those who would like to be promoted

to a supervisor, manager, investigator or developed positions.[14] Since all these training

measures and simulations are under the remit of leading European institutions, it is

appropriate to describe their profile and role in this regard briefly.
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1.4.1 European Union Aviation Safety Agency

As it was said in the previous chapter, EASA’s Easy Access Rules for ATCO Licensing

and Certification[12] is an accessible and efficient way to introduce the Commission Reg-

ulation (EU) 2015/340 document[2].

Established in 2002, European Union Aviation Safety Agency (EASA) is the most im-

portant aviation safety agency in Europe. Its significance can be found in certification,

regulation, standardisation, investigation and monitoring of aviation market throughout

the Member States. But only Europe is influenced by EASA Regulations. After over 18

years in operation, 31 countries became Member States (European Union, plus Switzer-

land, Norway, Iceland and Liechtenstein), but EASA also has permanent representation

overseas. In Montréal, Canada; Washington, D.C. of USA, Beijing in China and Singa-

pore, the Agency is promoting the European standards and inspiring the world from their

headquarters in Cologne, France; while also having offices in Brussels, Belgium.[15]

Their mission number one is to ensure the highest common level of safety. Apart from the

safety mission, EASA focuses on sustainable aviation and zero emission. Another task is

to provide oversight and support in fields where the Agency has shared competence; air

traffic management can serve as an example.[15] This is why the Agency is relevant for

this thesis.

1.4.2 Eurocontrol

Another institution that vastly contributes to the development of ATM is Eurocontrol. It

is the organisation to set standards and best practices for initial ATCO training (named

ATCO Common Core Content Initial Training[16]) that is referenced and transposed in-

side of the Commission Regulation (EU) 2015/340 together with requirements for medical

assessment of ATCOs, also developed there.

Eurocontrol – also known as The European Organisation for the Safety of Air Navigation

– is a pan-European civil-military organisation dedicated to supporting European avia-

tion and maintaining safe, seamless, and sustainable air traffic management across Europe
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with minimal environmental impact. It was founded in 1963. Having over 50-year-long

expertise, they support the member states and stakeholders with technical excellence,

data, simulations, recommendations and standardisation. This is all part of a joint effort

for Single European Sky Initiative.[17]

The hierarchy of Eurocontrol is quite simple. The Permanent Commission (PN, sometimes

also ‘enlarged Commission’) is responsible for electing the Director General, approves an

annual budget and accounts, five-year programme, and deals with some other important

administration. The other governing body is the Provisional Council (PC), responsible

for the Agency’s general policies and for preparing work for the PN. Both the bodies are

of course represented by member states’ delegates. The structure is nevertheless further

divided, but it is not the scope of this thesis. Briefly mentioned, there is the Audit Board

and Enlarged Committee for Route Charges. The Audit Board is one of the Agency’s

main advisory and consultative groups and it is a part of the Provisional Council. The

Enlarged Committee for Route Charges takes care about the operation of en-route charge

system. The word ‘enlarged’ here means that even a non-member states can join, if they

use the en-route charge system.

The Eurocontrol offices are located in:

• Belgium (Headquarters in Brussels),

• France (Experimental Centre – EEC in Brétigny-sur-Orge),

• the Netherlands (Maastricht Upper Area Control Centre – MUAC at the Maastricht

Airport),

• and Luxembourg (Institute of Air Navigation Services – IANS ).

Apart from forty-one European member states (from European continent only Russia,

Andorra, Iceland, San Marino and Holy See are missing), Eurocontrol also has a compre-

hensive agreement with Israel and Morocco. The Czech Republic is one of the 41 member

states of the organisation since 1996.
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In the context of this work, the focus is laid on the French base – Eurocontrol Experimen-

tal Centre in Brétigny, which is located near Paris. This ‘innovation hub’ of Eurocontrol

is supporting the digital transformation of European air transport. EEC is working on

establishing a European network of innovation labs, which are provided with innovative

solutions developed by EEC. That includes airlines and airports across Europe. Other

main activities of EEC include simulation, drones and UAM (Urban Air Mobility), and

coordination of projects within SESAR.[18]

Because simulations are a significant part of the Eurocontrol agenda, since 1980, over 100

simulation exercises have been conducted per year, in a framework of over 450 simulations.

Over 2000 ATCOs have participated in real-time simulations carried out at Eurocontrol.

Hence, the role of this organisation for this thesis is evident. Eurocontrol has unmatched

experience in the world of ATM simulations.
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2 Simulators at the Department of Air Transport

A various number of simulator types are an essential part of the Department. They

account for education and training activities, but also science and research. Firstly, it

is worth mentioning the flight simulator where the flight procedures and navigation are

simulated and trained. It is mainly used for training future pilots or testing students’

knowledge in subjects concerning flight navigation or flight equipment, but anyone from

the academic community can use it for their work after an agreement from the simulator’s

respective supervisor. A list of all the flight simulators present at the DoAT as of 2021 can

be found below. The first one is under administration of Laboratory of Human Factors

and Automation in Aviation, and the others are more or less under Laboratory of Air

Traffic Operations’ administration. The thesis and works concerning these simulators are

linked or referenced where applicable.

Figure 2.1: Airbus A320 simulator of the Department of Air Transport (source: author’s

photograph)

The flight simulators include:

• virtual reality simulator of Boeing 737 with biofeedback features,

• twin-jet aircraft simulator (Airbus A320)[19, 20] in picture 2.1,
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• military jet aircraft simulator with virtual reality capability (L-39),

• MEP (twin-propeller aircraft) simulator (Beechcraft)[21] in picture 2.2.

Figure 2.2: Multi-Engine Piston (MEP) Beechcraft Simulator of the Department of Air

Transport (source: author’s photograph)

A simulator used for training pilots in precise terminology and radio telecommunication

is also a section of the Laboratory of Air Traffic Operations and is a part od the pilot

training curriculum. The simulator was founded by Milan Kameník, M.Sc., and it is

currently located at the Faculty. It includes four communication booths for students,

radio station and a big magnetic map on the wall. The map includes a few airports of

the Czech Republic and neighbouring countries, namely Prague (LKPR). Brno (LKTB),

Zábřeh (LKZA), Katowice (LPKT), Linz (LOWL) and Bratislava (LZIB). In the labora-

tory, they are using small magnetic aircraft which resemble its movement in the airspace

according to the pseudo-pilot’s instructions.

A new teaching aid is also taking shape. It is intended for a workshop (in the scope of

21RTS – Radiotelefonie a spojení subject) taught at the Faculty of Transportation Sci-

ences. A simulator of simple ATC and radio correspondence that is based on Openscope

simulation tool2, should be an easy way to introduce simulation and radiotelephony to
2available online on https://www.openscope.io/, see screenshot in figure 2.4
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students with no basic knowledge of the matter. In the near future this tool is going to

be improved and adjusted to the DoAT education needs.

(a) Communication booths (b) Part of magnetic map

Figure 2.3: The Terminology and Telecommunications Simulator (source: courtesy of Milan

Kameník, M.Sc.)

Figure 2.4: Openscope Simulator screenshot

The expansion of Openscope is supported by EuroTeQ. EuroTeQ is an alliance of six Euro-

pean technical universities (including Czech Technical University) and 45 other associated

partners[22]. The EuroTeQ Teaching Fund could extend the abilities of the Openscope
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simulator. By the end of 2021, the improvements will have been incorporated into the

simulator so that the summer semester of 2022 is the first to run this subject. The things

that need to be improved or edited are, for example:

• radar display projected to students (no info or strips displayed),

• instructor station (adding spawn/remove function of aircraft),

• interface for trainees/students (extended display and control),

• other things in system logic and functions, optional ‘nice-to-have’ functions.

Because all of the above-mentioned simulators are helping to extend the educational and

research abilities of the university, the reason for describing these simulators is a possible

future initiative to create an inter-connected multi-simulation platform at the Depart-

ment. This is described in section 6.3.

Another field of simulations is accounted to the Laboratory of CNS/ATM Systems. All

the research topics of the laboratory follow Communication, Navigation, Surveillance and

Air Traffic Management scheme. Research studies on GPS signal jamming, 1090 MHz

radio frequency band pollution or multilateration can serve as examples. The laboratory

also broadly cooperates with a Czech company ERA, a. s.3, which supports the labo-

ratory with some of the technicalities and provides equipment. The main subject of the

thesis – a distribution of ESCAPE simulator by Eurocontrol – is located in the laboratory.

The simulator tool and then its current state at the Department will be described in the

following chapters.

3https://www.era.aero/cs
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3 ESCAPE

Out of the many activities of Eurocontrol, one of the most significant projects in terms

of simulations is ESCAPE. It was developed by Eurocontrol for research, operational val-

idation and training. The full version is capable of providing a user with a compelling

human-machine interface (HMI) tool kit, high fidelity aircraft performance (based on air-

craft data), datalink, collision detection tools (Medium Term Conflict Detection – MTCD,

Short Term Conflict Alert – STCA, ...), or arrival manager. For an analysis, ESCAPE

offers a wide range of tools (recording of all the inputs, trajectories, noise map, gas emis-

sions, ...), it is compliant with Single European Sky ATM Research, and the software is

provided free of charge for Eurocontrol Member States.[23]

Apart from describing the ESCAPE platform as a whole, the author will present an an-

thology that will include the features that are used by the DoAT ESCAPE team, or those

that are known to be present in the ESCAPE Light simulator. This comprehensive yet

brief description would not be found anywhere publicly. Because some of the internal

documents are either long (and including all the smallest details) or fragmented, author

will derive the anthology from his experience with the simulator. Nevertheless, the au-

thor’s experience is derived from the documents, workshops and support from Eurocontrol

representatives. Therefore, the anthology is one of the outputs of the thesis.

ESCAPE is Linux-based simulation software. This scalable modular real-time simulator

brings support for both small- and large-scale simulations. The middleware for dynamic

communications between ESCAPE components is based on Corba (Common Object Re-

quest Broker Architecture). This architecture ensures that communication over the net-

work between computers of a particular platform is facilitated. In general, that means

there is a server that offers objects to clients that invoke it. The communication details

do not need to be described, but it is useful to introduce this middleware to better un-

derstand ESCAPE overall system architecture.
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For the purpose of this thesis, the term ‘machine’ has to be defined. The ESCAPE simu-

lator comprises four types of machins that work together thanks to the above-mentioned

Corba. According to the specific type of distribution, slightly different step-by-step sce-

narios are followed to install the machines on the required set of computers. Since ES-

CAPE runs on Linux (particularly the CentOS distribution), it can either be installed as a

native operating system (OS) or it can be virtualised inside of another OS (e.g. Windows).

The operation and control of the simulator is then identical no matter the OS, but the

native version can be more user-friendly and less confusing. On the other hand, there are

not many ordinary users familiar with Linux, in which case it can be helpful to virtualise.

When a particular set of machines is connected, it can be called a simulation ‘platform’.

Because of high computing demand, each computer is required to have at least an Intel®

Core™ i7 CPU (i7-6700HQ and higher), 16 GB of DDR4 RAM, over 500 GB big hard-

drive/SSD (just the total volume, a simulator machine with virtualisation will fill up to

5 GB of space at worst) and a performing graphics card.

The graphical interface comes in two different forms. From the user view, Ground ma-

chine and IPAS machine have a graphical user interface called GNOME (GNU Network

Object Model Environment) that is easy to use for anyone unfamiliar with programming,

as GNOME looks like the desktop of Windows or macOS operating systems, known to

almost everyone. Interaction with the interface is straightforward as it includes some of

the primary applications like a text editor, a spreadsheet developer or an e-mail client.

While working with the ESCAPE simulator, the user only performs some basic folders

and files administration but mainly works in terminal, which needs basic programming

skills.

The other two machines – Controller and Pilot Working Positions – work in an interface

called EONS (stands for Eurocontrol Open and geNeric graphic System). For the user,

the interface consists of just three Terminal windows on the screen. A user will not need
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them during normal simulator operations, but for an administrator or simulator manager,

it will be used for some actions in order to manage, connect or edit the machines.

The first prerequisite for proper functioning is the need for the machines to be connected

to the same network. That ensures establishing the proper Corba communication. Un-

less pre-prepared by Eurocontrol, the connection has to be set by providing Linux IP

addresses of all machines of the platform to each machine. Namely, files that have to be

updated inside the machines are listed in the table 3.1. The file paths are the same for

all the machines. It is necessary to include every machine of the platform in those. The

machine names can be found for example in tables 4.1 and 4.2. However, these actions

are not recommended to be carried out by users alone. It is easier to do it in GNOME

interface. In EONS, a user would need to manage a number of basic Linux commands

(cd, vim/gedit, ll, ...).

Table 3.1: Connection establishment essential files (source:[24])

File path Pattern

/etc/hosts

<IP address> <MACHINE name>

<IP address> <MACHINE name>

...

/etc/X0.hosts

<MACHINE name>

<MACHINE name>

...

/etc/X1.hosts

<MACHINE name>

<MACHINE name>

...

Each of the simulator machines has a different function in the platform. The default num-

ber of a platform’s machines is four - ground machine, controller, pilot and Integrated

Data Preparation and Analysis System (IPAS), but it can be extended. More precisely,

the number of controllers or pilots can be increased. Of course, depending on the com-

puter’s performance, multiple machines can be hosted on a single computer unit, thanks
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to virtualisation. That is all depending on the required exercise complexity and simu-

lation characteristics. The description of four machine types (Ground Machine, CWP,

PWP, IPAS) follows:

3.1 Ground Machine

The ground machine (often referred to as GND or GROUND) is the heart of the platform.

It is necessary for running the simulator, and all the ESCAPE files that depend on it are

saved on this machine. The flight data processing is carried out on this machine, as well

as the radar processing. It stores the flight plan and surveillance data and distributes it

to be read by the other machines. Also, the BADA (Base of aircraft data) files are stored

on this machine. For any given platform, only one Ground Machine is needed, and it

generally requires the most computing power because of all the services running there.

Generally, the ground machine serves as a supervisor’s station. A supervisor can easily

start/stop the exercise or have an overview of an exercise. The supervisor controls the

course of the exercise. After completing the basic steps covered in Appendix (A.1 and

A.4.2), the exercise is being started. The ‘Don’t Panic’ window at the top left of the screen

signifies loading. Apart from other windows, the same environment as the Controller

Working Position one is displayed. After the Time Controller window is showed, the run

is ready on all machines, and it is set to be unfrozen – to be run.
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Figure 3.1: Ground Machine Time Controller (source: author’s screenshot of the simulator)

Table 3.2: Location of necessary files of ESCAPE on Ground Machine4

Location folder Description

/data/exercises/bach Files needed to compile exercises

/exercises/bach/UNISCAPE/recording/ground
Contains saved logs and recordings

from exercises for offline assessment

/exercises/prepesc/Simulations/UNISCAPE/appli/CWP/config/..

..CSV_FILES

CSV files of MAPS data

(custom maps setting on radar)

/exercises/prepesc/Simulations/UNISCAPE/appli/CWP/config/..

..SIMU

ORG – Organization data

(for correct architecture environment)

/exercises/prepesc/Simulations/UNISCAPE/appli/CWP/config/..

..SIMU/CSV_PROD_FILES

LAYOUT – Layout of controllers

responsibilities and roles

Further below, several main components displayed during an exercise will be described.

In the scope of controlling time and speed of the exercise, the fundamental component

is Time Controller (see figure 3.1). The user can see the exercise time but mainly can

adjust the speed of the exercise by moving the slider and setting the Rate up to 10 times

the normal speed. It should not be forgotten to press Apply after changing the slider po-

sition. The exercise can also be quickly frozen/unfrozen from this component by pressing

the yellow Unfreeze button (which turns to red Freeze button after clicked).

The time can be alternatively controlled with the help of General Toolbox toolbar on Con-

troller Working Position (see chapter below). On Ground – because it runs a supervision
4Note: UNISCAPE in path is the name of a simulation, if needed, substitute an appropriate one
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position that is basically a feed position for the pilot and controller – there is this toolbar,

too, although without the TIME option. That is because GND has the Time Controller

available instead. For the Controller Working Position version of General Toolbox, see

figure 3.9a). To sum up the General Toolbox, which will be described in more detail in

the CWP chapter (section 3.2.1), the most frequently used buttons are:

• TIME – clicking it will also display a FREEZE/UNFREEZE option, but not the

Rate (speed) settings, only on CWP machine;

• Pref – only used function in ESCAPE Light is the loading and saving of custom set

up (labels, map display, colours, etc.) on the top of the window,

• Tool – for setting up colours of the items and objects (Colours option), and reor-

ganising the label and its properties (ATC Objects).

For checking the exercise status as a whole, the Supervisor window is used (see figure

3.2). The user can see the status of all the components running there. When unfrozen, all

the lights next to all the components should be green. In the lower part of the window,

there are a few buttons used mainly to check or debug the exercise. For example, the user

can save logs and recordings from there, see the CPU load, quickly freeze or unfreeze the

exercise, or restart the exercise. There is also a button to Exit, which stops the exercise

and closes all the windows on all of the platform machines. This is the only right way

to end the exercise. Otherwise, there may be errors preventing an exercise from running

again.

Next, two of the tools for the exercise installing, configuring, launching, and monitoring

will be described. Those are generally run while the exercise is not running on GND. The

first is a tool named run_escape that contains a set of scripts needed to load the exercise

into the Ground Machine Run Selection Tool. At least, that is what it is mainly used

for at the Department of Air Transport (refer to Appendix A.3). This needs to be done

after any delivery of an exercise inside of IPAS machine. The other cardinal tool is called

launch_spv or the Run Selection Tool, and it serves as a launcher for exercises and their

runs.
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Figure 3.2: Supervisor window on Ground Machine (source: author’s screenshot of the

simulator)

3.1.1 Run Escape Tool

Run Escape tool, launched by entering command run_escape -u uni in the terminal

of GND, is a tool for installing the IPAS-delivered exercise into the Run Selection Tool,

which is described in the following subchapter. The navigation and control of this tool

are pretty simple. A user only needs to follow the desired commands affiliated with its

respective options.

As it can be seen in the picture 3.3, there is a plain user interface, where each option is

marked by a number. This number is then chosen by typing the number on the keyboard

and affirming it with the Enter key. Alternatively, there are options to return to the

previous window and menu (b) or exit the tool completely (x). It is a very technical tool,

that is why only one process – but the most important – is described in the appendix

(section A.3).
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Figure 3.3: Run Escape tool (source: author’s screenshot of the simulator)

3.1.2 Run Selection Tool

Run Selection Tool, launched by entering command launch_spv -u uni in the terminal

of GND, is a tool primarily used for running an exercise run. The tool and also the basic

hierarchy can be seen in the picture 3.4: Each simulation contains a set of exercises, and

an exercise has its own set of runs. Having runs is useful for carrying out an exercise each

time with a slightly different settings or architecture.
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Figure 3.4: Launch SPV tool (source: author’s screenshot of the simulator)

When an exercise is new and recently deployed by run_escape tool (see chapter 3.1.1 and

A.3), it has no Runs available. Those can be created by the Create/Edit Run button,

where the settings of a run can be set. Also, the connections throughout the Ground

Machine and its servers are checked and connected. Afterwards, there are additional run

settings (like a Time Controller on/off option, organisation environment, or ECHOES

database configuration). The course of steps in order to create a run is thoroughly de-

scribed in appendix A.4.1.

3.1.3 MAPS

In the following subsections, an internal training presentation by Eurocontrol is used as

the main source[25]. The rest is based on the author’s experience and observations.
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The Ground Machine also stores maps data, in other words – a set of radar display im-

plementation of the ATC data that will be displayed as default when the CWP radar

interface is run (either on GND or CWP). By default, there was no such representation,

and after designing an exercise, there is just a blank display. At the Department, a pro-

vided maps file has been adjusted to the DoAT needs.

The maps file is an editable Excel file that is then saved into a CSV compatible with ES-

CAPE. It can specify the representation of designed navigation points, airports, airways,

SIDs, STARs, sectors, and volumes from the database. Additional custom points, lines,

curves, or rulers can be added. A label, line colour, background colour, and other param-

eters can be set for some of the elements. The assortment of colours is also defined in the

CSV maps file. The elements settings then reference the colours from the assortment.

A completely default CSV maps file can be seen in the picture 3.5. It is divided into a

few sections (columns):

• Menu Definitions – declares where and for which roles and organisation the par-

ticular record is going to be displayed.

• Maps Usage – used to identify which kind of object is represented in maps by this

record.

• Line Properties – only for objects that include lines, e.g. volumes, sectors, lines,

SIDs, STARs, but not airports or waypoints.

• Area Properties – only for objects that can show an area, therefore exclusively

for volumes and sectors, but not lines and paths, nor points.

• Point Properties – similarly, only points and airports will be affected by these

properties.

• Ruler Properties (not shown in the picture) – only for rulers. These are generally

used for final approach path representation and for controllers to have an idea about

the distance.
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• Priority (not shown in the picture) – sets the masking of the object record (above

all, in the middle, behind all).

Figure 3.5: MAPS config template file (source: author’s screenshot)

Figure 3.6: Organization folder arrangement (source: courtesy of [26], reworked by author)
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3.1.4 Organisation

Organisation, or commonly named ORG, is a directory structure that determines the

correct controller’s responsibilities and roles. In the path stated in table 3.2, an unlimited

amount of ORG folders can be created. The unique name of the folder is the name of the

organisation, inside there is a UNI folder (because we are working in UNISCAPE project),

and then the intended controller positions – HYBRID for hybrid (feeding) positions, TC

for an executive controller, and PC for planning controller positions. For illustration, this

can be seen in the picture 3.6.

3.1.5 Layout

The layout files are essential for refining the name and associated ATC centres for each

sector defined in the exercise. There is a bijection between the ORGanization and Layout.

It should nevertheless be in correlation with the IPAS data. The layout is also important

for defining the rules for flight transferring from HYBRID (FEED) controllers.[25]

The structure of Layout is a text file of the following pattern.

<Controller ID>;<Sector>;<Role>;<ATC Center>;<Project>;<Kind>;<options>

In the file, each controller of the exercise should have its unique line written in the file. The

file location is stated in the table 3.2. Its name is always along the LAYOUT_<LAYOUT_NAME>.txt

pattern. The dependencies between IPAS data, ORGanization, and Layout can be seen

on picture 3.7 with the example of ORG_ULD that has been created for exercises at the

Department. It is essential to follow this pattern while designing an exercise environment

in ESCAPE.
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Figure 3.7: IPAS, ORGanization and Layout dependencies (source: author)
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Figure 3.8: STORIA Analysis Tool window with AD exercise loaded (source: author’s

screenshot of the simulator)

3.1.6 STORIA Analysis Tool

There is a dedicated tool on the Ground machine for assessment and detailed analysis

of the course of an exercise. After the logs and recordings are saved during the ending

process of an exercise, the STORIA Analysis Tool (SAT) can be started and the files

loaded in. STORIA is the component needed for recording the course of an exercise. The

SAT can show a 4D trajectory of every aircraft of an exercise. Additionally, all the pilot’s

inputs and instructions are logged there, it also includes the static data (the same ones as

input in IPAS in order to create the exercise). The SAT window can be seen in picture 3.8.

Even for ESCAPE Light version, SAT provides a lot of recorded data to be assessed by a

user. Some of the capabilities of SAT are listed below.

• In ‘Replay’ perspective (Perspective → Replay), the whole exercise can be replayed

both in real-time and up to 60 times faster.
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• In ‘Analysis’ perspective (similarly), a number analysis reports can be carried out,

including graphs and tables of several exercise details.

• In ‘Static’ perspective, for example, the airspace elements or recording of 4D aircraft

profiles can be displayed.

The basics of navigating in SAT are a little different from the other tools present in ES-

CAPE. After choosing an item from the database at the bottom of the SAT window, it

is shown in the radar window. Then, each of the following selected items or records from

a different table are added to the display. To clear the radar window, a user has to use

a long press of the right mouse button in the lower part of the SAT window and with

the button pressed, hover on the ‘Clear selected items’ option. Afterwards, the choice is

up to the user – either the showed items from the current table will be cleared from the

radar window, or all of them will.

Any outcome of the assessment and analysis can be exported into an XML file; the paths

can be exported into Google Earth KML archive. The radar screen can be saved as a

JPG image.

3.2 Controller Working Position

The Controller Working Position (CWP or just ‘controller position’) is the core position

for conducting an exercise in a simulation. When the simulation is not running, this

position only shows three terminal windows by default (the EONS environment) and a

user has only access to the machine via the terminal. After an exercise is started through

the Ground machine, the CWP runs an environment needed to show the radar and other

tools. Loading of this environment is signalised by showing ‘Don’t Panic’ window at the

top left of the screen. The loading itself includes opening many windows; during this op-

eration, the user should not interfere. According to the complexity of the loaded exercise

and computing power of the computer, it can take some time.
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(a) General Toolbox window

(b) Radar Toolbox window

Figure 3.9: General and Radar Toolbox window (source: author’s screenshot of the simulator)

When loaded, the radar window is displayed, as well as several controlling panels. After

the time controller on the Ground machine is displayed, loading is complete. The user

can resize and zoom the radar window and set some of the parameters of the interface,

show or hide map elements. Two of the main windows used to interact with the settings

of the CWP position are shown below.

3.2.1 General Toolbox

The majority of the General Toolbox features and options are either locked or hardcoded

in the functional database of ESCAPE. Therefore, there is not much to describe about

the General Toolbox, apart from the TIME control that was already mentioned. After

clicking TIME button, the controller can unfreeze or freeze the exercise, without the GND

intervention. Clicking the time on the right side of the toolbar will minimise the toolbar

and only show the time.

Another feature is saving of custom settings that were made inside of both the Toolboxes

(mainly the Radar one). This feature is accessed through the Pref button and located

right on top of it, where it says DEF, 1, 2, 3. These are the possible slots to save the

user’s settings; DEF being the default one to load – it cannot be saved into.
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After clicking the Tool button, a window will open with Services tab opened. These are

the above-mentioned settings that are hardcoded in the database and cannot be changed,

even if they seem like it is possible. The tabs that are of interest for this thesis are Colours

and ATC Objects.

It is self-explanatory what the Colours tab is about. Inside the tab, a user can temporar-

ily change the colours of radar objects seen in the Radar Planview Display. Temporarily,

in this context, means that the colours will reset to their default (MAPS) state after re-

running the exercise. It can nevertheless be saved in the slot of the Pref button, described

in the previous subchapter.

Sometimes, it is unclear what colour is about to be changed, and the user usually has

difficulties finding the intended colour in the records listed. It is therefore recommended

to use the MAPS capability, as it is more user friendly, predictable and customisable.

TheATC Objects tab enables to change aircraft label layout and its font. After navigat-

ing to ‘All Aircraft Design’ section, the user can choose a colour for each of the states of

the aircraft (unconcerned, assumed, etc.), label box, or track history presentation. There

is a menu at the left side of the window, where more settings can be found for different

filters of aircraft. For the label settings:

• All Aircraft Unselected Fields – what will be shown on the label when the aircraft

is not selected on the radar,

• All Aircraft Selected Fields – what will be shown on the label when the aircraft is

hovered on (‘mouseover’) on the radar.

3.2.2 Radar Toolbox

The Radar Toolbox directly influences the representation within the Radar Planview

Display window. On the bottom of the Radar Toolbox, a zooming slider enables zoom

the map. In the same section (see figure 3.10), there are a few buttons (from left):
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Figure 3.10: Zoom section of Radar Toolbox (source: author’s screenshot of the simulator)

• Focus tool – clicking the button and then a place on the map will make the clicked

place the middle of the screen.

• SAVE button – saves the current zoom level to the slider (max. 3). Will change to

DELETE button when on saved position.

• Circle radar range – shows/hides a circular radar range in the map.

• Orthogonal radar range – shows/hides orthogonal rulers on the edge of the radar

window.

The section on the right side of the Radar Toolbox enables to change the length of speed

vectors of aircraft and their track history – shown in minutes. At the top, there are a few

important buttons:

• MAP. The map menu enables a user to toggle individual sections of the MAPS file

(see section 3.1.3) currently used. For example, some map elements are only desired

to be shown occasionally during an exercise. This can be done in this menu.

• LABEL. Quick changes to the aircraft label can be done here; it is mainly used

to toggle some of the label fields without any additional position or colour settings.

For more detailed label settings, use the General Toolbox ATC Objects settings.

• OVERLAP. Controls the label position on the map relative to each label. It takes

some experimenting for the user to reach desired options, but generally, the AUTO

button tries to never overlap any labels; the label position can be set according to a

filter (by flow, by departure, by destination), and the relative position to the aircraft

can be controlled.
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3.3 Pilot Working Position

The pseudo-pilot (Pilot Working Position – PWP, sometimes also ‘pilot position’) looks

the same as the CWP position when the simulation is not running. When an exercise

is started, loading of the PWP position is signalised with a map of Great Britain in the

centre. Then, the whole pilot position is loaded, but apart from a small radar window at

the top left, no flights can be seen until the exercise is unfrozen on Ground machine.

During the course of an exercise, the pilot’s console is pretty straight-forward, yet powerful

tool. For the representation of the pilot position, see figure 3.11. By default, it is divided

in multiple sections, but the distribution of the functional elements can be adjusted in

the database. There is a radar window on the left side, fairly different from the CWP

position, although they share some features with it.

Figure 3.11: Pilot Working Position console (author’s screenshot of the simulator)
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The AIRSPACE button is practically a PWP version of the MAP button on Radar

Toolbox. Next to the button, there is a slider that zooms the airspace shown. For the

other buttons, their description is shown when hovering over a particular button. On the

top of this section, there is the exercise time, and the top left corner shows the position

number and its frequency.

The most significant section is the flight list on the right. According to the relationship of

ETO (Estimated Time Over significant point) of flights and the exercise time, the flights

at the top (with blueish background) are the flights yet to appear on the radar. The

flights at the bottom are currently active aircraft that are ready to be controlled.

The aircraft control is covered in the following description of the bottom section of the

console, but first, the columns of the aircraft list will be explained. The names of the

columns are located in the middle of the screen.

• AIRCRAFT. Button used for ordering the aircraft alphabetically. Clicking on a

record in this row will enable to control the respective aircraft.

• HLS. Clicking the three arrows on a respective row will enable control of heading,

level and speed at the same time.

• HEADING. For setting the required heading of a particular aircraft.

• LEVEL. Button used for ordering the aircraft by their level. When clicking on a

record in this column, the user can change the desired level of the respective aircraft.

• SPEED. Clicking on a record will enable to set the required speed.

• FRQ. Used as a shortcut for quick transfer of an aircraft.

• BEACON. Button used for ordering the aircraft by the name of the next beacon

of an aircraft path. Clicking a record in the column enables to plan next beacons

in the respective aircraft path.

• ETO. Estimated Time Over significant point. Clicking on a record in this row will

enable to control the respective aircraft.

52



Faculty of Transportation Sciences
Czech Technical University in Prague

• Flag between ETO and PACK columns enables highlighting of the respective air-

craft.

• PACK. Button used for deleting empty space in the list of flights, between the

records. The empty space results from an aircraft completing its path and disap-

pearing from the radar.

By using the above-mentioned buttons and navigating through the flight list, the ‘orders

groups’ section (located on the bottom left portion of the PWP window) provides a list

of possible orders that can be given to the particular selected aircraft. When there is

nothing selected, the orders groups window (which is called ‘Aircraft’ at the moment)

shows an unordered list of flights callsigns in the table. Those can be selected in order to

open the possible orders, too.

The list of possible orders groups can be seen in figure 3.12. The names of the orders

alone should suggest their function in the console. Some of them have the same function

as the orders given directly from the aircraft list at the top of the window, as those are

generally quicker to use.

Figure 3.12: Orders groups section of PWP console (source: author’s screenshot of the

simulator)

3.4 Integrated Data Preparation and Analysis System

The Integrated Data Preparation and Analysis System (IPAS) machine is crucial for

creating new exercises and editing the existing ones. It has GNOME interface – the same
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as Ground machine – in order to navigate easily in the system because on this machine,

files management is fairly useful and important. The leading utility needed for the creation

and preparation of an exercise is run by navigating into a terminal window in Linux and

running ipas command. The IPAS Supervision window is then shown. It is displayed in

figure 3.13, and it is divided into several sections below.[27] Note that some of the parts in

this chapter may overlap with the chapter 5, as the exercise creation process is described

there in greater detail and some of the actualities explained.

• Menu area at the top of the IPAS Supervision window.

• Simulation area right below the menu area.

• Component area composed of 11 buttons on the left side.

• Context area is the rest of the window.

Figure 3.13: Integrated Data Preparation and Analysis (IPAS) supervision window (source:

author’s screenshot of the simulator)
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The menu area is helpful for deeper database data and maintenance administration.

Graphical data can be prepared by File → Open option, or IPAS parameters set. The

whole simulation can be backed up by the Administration → Maintenance option. By

the Help option, the user can read a user manual for getting a more detailed explanation

of the functions.

Simulation area shows the currently selected simulation, and an exercise and its domains

in the respective fields below. The buttons in the left of the context area enable to choose

exercise and its domains by clicking the respective buttons. The bottom section contains

three functional buttons: Clear to clear all the fields, Validate to load the selected simu-

lation/domains set, Cancel to get back to the state before clearing out the fields.

In the context area, a user can select an exercise that is about to be edited. Afterwards,

the functions of the component area can be used, or the database of the exercise domains

edited by using ‘Jump To’ buttons next to the respective fields. In order to get an idea

of the functions available in the component area, the list briefly describing them follows.

• CHECK contains a fundamental component that is needed for checking the exer-

cise database for errors before delivering the data from IPAS machine to Ground

machine.

• DATASET is where new exercises can be created, as well as the domains the

exercises consist of.

• IMPORT a big amount of data in the CSV format at the same time by the Import

function.

• EXPORT data from the database in a batch. Useful for getting familiar with the

format, as the same pattern is used for importing.

• ART VISU is a graphic preparation feature, where a user can see all the elements

of airspace that are prepared in the database. By the ‘Airspace’ menu at the top of

the window, the user can show specific airspace elements. Along with the mouose

cursor’s movement, there are coordinates shown at the right of the window. That
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can be useful for transferring specific points into the database by transcribing them

into the data input. The graphic preparation interface is refreshed after the exercise

is delivered.

• ART ANALYSIS is a function for flight path analysis and conflict builder. For

analysis purposes, a user can play the exercise in real-time or up to 60 times the

speed. The user can see if the aircraft follows the intended path, intersects each

other’s paths at the intended place, etc.

• VIEW. Powerful function for showing filtered data in text format. For example,

the user can show data of points not used in the current airspace or a list of airspace

objects using particular points.

• PVT – Profile Validation Tool. Enables batching data of flights and IPAS data in

order to prepare trajectories and profiles of the flight.

• ECHOES HMI graphical function allows showing the graphical representation dur-

ing exercise creation. It requires the same MAPS CSV file as the Ground machine

(chapter 3.1.3), on IPAS machine in path:

/exercises/bach/UNISCAPE/escape/ECHOES_LIGHT_CFG.
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3.5 Conclusion of the Chapter

The ESCAPE simulator platform has been briefly described in this section. The major

simulation tool by Eurocontrol offers many capabilities for its users. This thesis cannot

grasp all of its features at once, as it is a very complex tool. Instead of letting the reader

get through complicated guides, the author’s experience brought an anthology that de-

scribes currently known features of ESCAPE Light, majority of which are used at the

DoAT.

The simulation platform consists of the Ground machine – the heart of the simulator,

Controller Working Position (CWP) – that includes the main radar arrangement, Pilot

Working Position (PWP) – pseudo-pilot position to control the aircraft, and IPAS – the

composer and creation tool of the exercises and the database center. They have a slightly

different appearance when started and can alternatively be run on the same computers.

The system runs on Linux but can be virtualised, which is more user-friendly. Through

IPAS, an exercise can be built, but it is fairly complicated for a newcomer. After the suc-

cessful check and delivery of the exercise, it can be run on the whole platform. Supervision

is launched on Ground, radar window on CWP and the pilot’s console on PWP when the

exercise runs. After the exercise, the logs can be retrieved and assessed by another tool

on Ground, called SAT.

Concerning a specific use case of ESCAPE, there is a light distribution of the software

that the Department of Air Transport currently uses. The next chapter deals with the

current state of ESCAPE at the Department and describes the exercises created.
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4 Current State of ESCAPE at the DoAT

As mentioned in the introduction, the DoAT invested resources into ATC/ATM simulator

deployment back in 2019. Multiple face-to-face workshops held by Eurocontrol took place

near Paris, France, in EEC. Among several other European universities and institutions

delegates, the DoAT representatives (including the author of this thesis) were introduced

to the simulator and gradually provided with extensive knowledge of controlling it. Cre-

ating this community, Eurocontrol has been continually providing online support and

upgrades for this tool while getting valuable feedback on the tool from the programme

members.

They intend to create a self-sustaining community of institutions and universities world-

wide that will share information, their usage and tips and tricks about the simulator to

the other members of the programme. Although the simulator has not been primarily

developed and intended for universities, this community should help in adjusting the sim-

ulator for educational purposes and shape further development of Eurocontrol software

in this way. The author and the DoAT team host this community.

The particular distribution of this simulator is a lightweight but high-performance version

of ESCAPE, called ESCAPE Light. It is intended for smaller real-time simulations for

training, research projects or small scale airspace improvements. The features of ESCAPE

Light are limited relative to the full version, but can be more or less chosen according

to a user’s needs.[23] An important point to make is that ESCAPE was not originally

made or intended for universities’ intentions and it is very demanding to deploy it there.

It requires an implementation of many additional solutions, aids, and tricks that need

to be invented or designed by the users themselves to overcome some of the discomfort

ESCAPE currently has. It is nevertheless a very potent tool.
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4.1 Current State of the ESCAPE Platform

The current simulation platform of ESCAPE Light at the DoAT (as of spring/summer

2021) consists of four computers stationed in the Laboratory of CNS/ATM Systems. The

location of each of the positions can be seen in the picture 4.1. The computers usually

work independently as a hot desk for any student or a teacher coming to the lab because

there is Windows 10 Home system installed on all the computers. In terms of users,

anyone can work on a user called ‘student’ and not interfere or accidentally break down

any files the simulator depends on. The ESCAPE Light simulator is installed as a means

of virtualization with the help of Oracle VM VirtualBox software. As it was mentioned,

the simulator works upon a Linux-based operation system, currently, it is CentOS 6.8

distribution. For a better overview of the current simulator computers basic properties

at the DoAT, see tables 4.1 and 4.2.

Figure 4.1: Simulation platform at Department of Air Transport (source: author’s

photograph with graphics)

These machines were installed thanks to Eurocontrol-provided VirtualBox .ova files that

make the installation easy just by importing these files into the VirtualBox environment.

They are pre-prepared machines ready to be run. Then, only a few necessary adjustments
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Table 4.1: Simulator 1 properties (source: author)

PC number 1 2

ESCAPE position Ground PWP CWP IPAS

Windows user name Ground_Pilot1 IPAS_Controller1

Windows IP address 192.168.1.20 192.168.1.21

Machine name (VirtualBox) empgrd01 emppil01 empcwp01 empipas01

VirtualBox machine IP 192.168.1.10 192.168.1.11 192.168.1.12 192.168.1.15

Table 4.2: Simulator 2 properties (source: author)

PC number 3 4

ESCAPE position Ground PWP CWP IPAS

Windows user name Ground_Pilot2 IPAS_Controller2

Windows IP address 192.168.1.22 192.168.1.23

Machine name (VirtualBox) empgrd01 emppil01 empcwp01 empipas01

VirtualBox machine IP 192.168.1.30 192.168.1.31 192.168.1.32 192.168.1.35

need to be made to run the simulator. The composition of the current platform and tables

4.1 and 4.2 may be outdated at the time of reading because every use case may require

a different set of CWP/PWP machines. It should nevertheless show a pattern in the

platform possible arrangement.

In order to save space and computer units, it is possible to have multiple positions on

one computer, thanks to virtualization. As seen above, there is Ground and Pilot on

two PCs, and Controller and IPAS on another set. That means there are two functional

identical ESCAPE simulators. The simulator’s versatility would also allow having a single

platform, where each machine would be on its separate computer. Similarly, due to the

flexibility, the platform could include multiple CWP and PWP machines depending on

the scale of an exercise.
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4.2 Current State of Exercises

In this subchapter, the exercises created for the purposes of the Department of Air Trans-

port will be introduced. There are 18 exercises that were made in cooperation between

the author of the thesis (who created the exercises inside of ESCAPE according to the

needs of the exercise manager) and exercise manager Stanislav Schmidt, who is designing

the exercises from the air traffic control and management point of view. The exercise set

is intended to be used in education, particularly ‘Air Traffic Control Operating Proce-

dures’ (Postupy a činnosti ATC) elective subject of the summer semester for bachelor Air

Transport students in their third year of studies.

The exercises should provide students with basic to moderate knowledge and skills of prac-

tical air traffic control. There is currently no other subject that would provide students

with such skills and experience. Those include but are not limited to:

• correct phraseology,

• ICAO English basics,

• basic rules of airspace (already a prerequisite from basic ATC subjects from earlier

in the bachelor’s study),

• maintaining safe, fluent and effective ATC,

• basic aircraft vectoring, horizontal and vertical separation, speed control,

• proactive planning of the traffic flow and coordination with other ATS (Air Traffic

Services) units.

All the exercises were tested and are ready to be used, including a pilot log, instructor

log and a set of paper strips, if needed. The pilot log is a document for the pseudo-pilot

at the Pilot Working Position that includes a timeline of the exercise, some of the ba-

sic properties of the exercise and most importantly, a list of non-standard situations or

controller-pilot conversations that the pilot has to initiate in order to fulfil the exercise

goals and targets as they were designed.
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The instructor log is intended for an instructor (that will generally be the teacher of the

subject). It contains the whole pilot log to monitor the progress of the exercise, but there

is some extra information about what the controller should say to be correct, what are

the possible mistakes of the controller that could occur etc. Sometimes, possible conflicts

and their solution is noted there, too.

In some of the exercises in the set, there is a possibility (or rather a feature) of using paper

strips in order to teach students how to operate with the aid of flight progress strips. The

strips and logs are located on the IPAS_Controller machine in ‘Logs and Strips’ folder

on the Desktop. If the paper strips are not used, either it is not needed for the matter of

the exercise, or the strip-less system is used inside of ESCAPE.

The main idea behind the created exercise set is the sequence of the intended level of

training. It is designed to start at the beginning, where the trainee has no previous ex-

perience and skills. Every subsequent exercise is a next step, where each time, there is a

new topic added. In the following subchapters, the exercises are introduced to the reader,

according to the timeline the trainees or students encounter them – i.e. from the easiest

to the most complex. The architecture and scope of the exercise are always described.

4.2.1 SQUARE

First exercise the students will encounter is called SQUARE (see table 4.3). As the

name suggests, this is a square-shaped airspace that is completely fictional. There are

also four no-fly zones (restricted, dangerous, prohibited – in the scope of the exercise it

does not matter which kind) areas. The trainee is not supposed to let the aircraft enter

those during the exercise, if not instructed otherwise.

The instructor’s job is generally to give specific instructions to the controller, e.g. ‘Now

vector this aircraft around this restricted area without entering it, so that you reach point

FINOR’. Also, the controller is not supposed to let the aircraft fly outside of the area
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of responsibility – the whole SQUARE airspace from ground to an unlimited level. In

conclusion, the purpose of this exercise is to:

• acquire the basics of controlling the system as a whole,

• familiarize with ESCAPE simulator,

• gain basic habits (get used to) provide ATS (mainly identification of aircraft proce-

dures),

• train basic vectoring of aircraft, including level change,

• use the phraseology and radiotelephony essentials according to Annex 11.

The SQUARE airspace may be seen in figure 4.2. After starting the exercise, three slower

aircraft consecutively appear at the airspace borders (points FINOR, SOFIX, NINTY,

respectively). Then the exercise is a free-flight regime, and the controller does what the

instructor says. Approximately 13–15 minutes later, the next three aircraft – that are

faster and higher – appear (points SOFIX, FINOR, TUSEV, respectively). It should

demonstrate how a faster aircraft behave in the airspace and how harder it is to vector.

The student does not have to keep any vertical separation as it is not the purpose of this

exercise. It is solely to grasp how to communicate with aircraft, manoeuvre them and

plan ahead. Therefore, it is not wrong if the vertical separations are lowered.

Table 4.3: SQUARE Exercise Description

Exercise Name SQUARE

Number of Aircraft 6

Max. Traffic Load up to 6

Paper strips (Yes/No) No

63



Faculty of Transportation Sciences
Czech Technical University in Prague

Figure 4.2: SQUARE Airspace (the different restricted areas can be seen, as well as 5 of the

navigation points; source: author’s screenshot of the simulator)

4.2.2 MAZE

Another group of exercises is called MAZE. Again, the name speaks for itself. The

airspace (see figure 4.3) is a maze that the aircraft has to follow and cannot drift or cross

the border of the airspace. That is the task of the controller. The airspace is 5 NM

(nautical miles) wide. The exercise is supposed to take the student’s vectoring, navigat-

ing, planning, and phraseology skills even further. The aircraft enters the airspace at one

side of the maze and should leave it at the other. There are two designated points for

that: that means that the aircraft either flies VEPOT→ SYRAM or SYRAM→ VEPOT.
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The aircraft have to be navigated correctly through the maze. Sometimes it is also needed

to take care of vertical separation using different levels. Most importantly, a new mode

is introduced to the student. Most of the aircraft leaving the airspace have an estimated

time to be followed, or revised if needed. The instructor’s role is to keep an eye on these

estimates, receive the revision changes, and remind the students to think ahead. Also,

there is a required level that the aircraft has to exit the airspace at and a requested flight

level (RFL) the aircraft has to cruise in. The trainee has to consider these tasks and

carefully plan ahead, coordinate the estimated time, or make a REV (revision) message.

The exit level at the exit point has to correspond either to the strip entry or the coordi-

nated one. If the aircraft deviates 5 or more minutes from the ETO, a REV message has

to be issued. If the deviation time is less than 5 minutes, an approval request should be

made. Also note that the separation is not provided for the edge of the airspace.

In some versions of the exercise, there is also some additional uncontrolled traffic in the

background crossing the airspace that the student has no control of. It is there solely

to confuse or disorient the trainee and to introduce some additional exercise complexity.

However, it is usually carefully planned to cross the MAZE airspace (while not changing

its HLS – heading, level, speed) when a controlled aircraft is just passing by inside MAZE.

Sometimes, the background traffic can be on a conflict course with this controlled aircraft.

The trainee is supposed to notice that and act accordingly.

The basic MAZE exercise has a similar concept as SQUARE. There are 3 aircraft ap-

pearing in the first 5 minutes that are slower and easier to navigate. After approximately

5-9 minutes, another 3 aircraft appear, but they are twice as fast. In MAZE01A, used

levels are more varied, and additional planes are added. However, for some opposing

aircraft, the level is the same, so if the separation is not followed and the trainee forgets

it, the aircraft may be in conflict when the aircraft meet halfway in the middle of the maze.

The paper strips are used in all MAZE exercises. The MAZE01B exercise is a slightly more

challenging version of MAZE01A. MAZE2 is even harder, and together with MAZE3, it
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has been developed as additional exercises for further training of the matter. By then,

the student/trainee should master vectoring, vertical separation and handing operational

messages. The MAZE2 exercise includes 17 aeroplanes, 8 of which are the background

traffic. MAZE3 is MAZE harder variation with background traffic.

Table 4.4: MAZE Exercise Description

Exercise Name MAZE MAZE01A MAZE01B MAZE2 MAZE3

Number of Aircraft 6 8 10 17 9

Max. Traffic Load 6 8 10 14 9

Paper strips (Yes/No) Yes Yes Yes Yes Yes
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Figure 4.3: MAZE Airspace (the entry points VEPOT and SYRAM can be seen; source:

author’s screenshot of the simulator)

4.2.3 AD

To this day, the most complex airspace of all the exercises created at DoAT is the AD,

which stands for Aerodrome. The exercises created upon this airspace are called RLP

(as in Czech phrase for Air Traffic Control – Řízení letového provozu). The exercises

are numbered RLPXYY, where X is the mode of the exercise (see the list below), and

YY is a number of the exercise in the particular mode. There is the whole vicinity of

an airport modelled, including CTR (Control Zone), CTA (Control Area) and TMAs
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(Terminal Control/Manoeuvring Area). A number of interesting elements can be seen

taken over from Prague, Nurnberg and other airports and airspaces. These elements

make the exercise challenging. Other than that, the exercises are completely fictional

again. The RLP exercises are then divided into three sets:

• RLP101–RLP104 (exercises focused on departures, familiarization with new envi-

ronment),

• RLP201, RLP202 and RLP203 (exercises focused on approach and arrivals),

– RLP201 is a purely director-focused (control only of airspace lower than FL70)

exercise, intended for sequencing and speed control training.

• RLP301–RLP305 (mix of the former two).

– For complex operations training (arrivals, departures, IFR/VFR, VFR flights,

flights to/from adjacent airports in TMA vicinity or below it, Czech phraseol-

ogy, non-standard situations – weather, go-around, etc.)

Generally, with a higher number of the exercise, the difficulty rises. Each set is focused

on a different mode of traffic, training different procedures and phraseology. In the en-

tire airspace, there are 8 SIDs (table 4.5), 5 STARs (PESAK, KORDA, DRM, ZERAN

and FUT) and 4 airports in total 4.6. The airport named LKAA is the main airport for

the exercise. The other three (LKXF, LKXK, LKXM) serve as adjacent airports, where

some additional traffic sometimes starts or ends in order to add complexity to the exercise.

Table 4.5: SIDs structure of AD exercises

SID Name

SID Type
Jet Prop All

KORDA X X

FILBA X X

JELIN X X

PORIV X

DRM X
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Table 4.6: Airports in AD airspace overview

Airport Controlled? RWY

LKAA Yes 09/27

(LK)XF No 01/19

(LK)XK No 01/19

(LK)XM No 01/19

Figure 4.4: AD Airspace (source: author’s screenshot of the simulator)

An exercise for research purposes has also already been created. It was built upon the

AD airspace, and it is 2 hours long. Its purpose is to support a thesis that researches

some physiological parameters of subjects. The 2-hour-long exercise is very challenging,

intended to test the limits of a subject. With 75 aircraft spanned over two hours, it is the
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most extreme exercise created at DoAT yet, as the traffic is very complex and comes in

waves of heavy traffic load and lighter traffic load.

Nevertheless, the creation of exercises is ongoing so that there are multiple versions of the

same one and students do not learn the aircraft or the logs by heart, which would decrease

the wanted results. That means the list mentioned above may already be outdated by

the time of reading.

There is, though, one more exercise made to ease the process of ESCAPE exercise creation

for new users. Despite being included in the AD airspace, it does not belong to the set of

exercises described above, and it is not a part of the training set for the school subject.

4.2.4 SPECIMEN

For the purpose of the thesis and future development and deployment of ESCAPE at the

Department, and for future users, SPECIMEN exercise was created. It was made in order

to show the easiest possible functional exercise. Because the initial process of exercise

creation takes a lot of time, error handling and debugging for a new user, this exercise is

an empty SQUARE exercise that contains just about everything for functioning and not

causing any errors or warnings.

Therefore, this exercise dataset can be duplicated and then the copy used as a training aid

for creating an exercise inside of IPAS. It can be customized into a user’s own idea or vision

as the database is empty, apart from some vital elements. Custom new airspace data can

be added or the square airspace modified, flights linked to it, different architecture chosen,

etc. In the picture 4.5, the SPECIMEN sector layout can be seen inside of the ART VISU

function.
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Figure 4.5: SPECIMEN sector layout (source: author’s screenshot of the simulator)

4.3 Currently Used Features of ESCAPE

As the default features of ESCAPE Light are limited compared to the full version de-

scribed on Eurocontrol webpages, there is a certain amount of features that the ESCAPE

team at DoAT cannot test. Some functions can be unlocked in the light version by Euro-

control, but it requires much coordination. Some of them cannot be unlocked because it

would not suit the policy of distributing ESCAPE Light and its sub-components.

Basically, every team from the ESCAPE Light community uses different features that

suit their individual requirements. Currently used features of ESCAPE Light at the

Department of Air Transport are described throughout this thesis.
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5 Exercises Creation in ESCAPE

The method of exercise creation in the ESCAPE simulator for the use of the Department

of Air Transport is slightly different from what the simulator is intended for. The ex-

ercise creation is mainly tailored to import a considerable amount of real airspace and

infrastructure data that should already exist in AIPs or other aeronautical sources. Then,

of course, there is a possibility of making some modifications and changes to this data

inside the exercise creation tool. At the DoAT, apart from re-creating a real airspace

environment, the most significant portion of activities currently concentrates on design-

ing fictional/artificial airspace. That is because education is currently the biggest part

of ESCAPE activities at DoAT and fictional airspace can teach virtually any ATC phe-

nomenon that the real airspace could lack. Therefore, it is necessary to describe how to

adjust the approach to successfully and efficiently build an exercise.

The majority of the exercise creation work is carried out inside of IPAS machine. Gen-

erally, it requires a user to more or less follow a specific step by step procedure. That is

because the system continually checks for any mistakes that would prevent the airspace

(and the exercise as a whole) from working correctly. Briefly described, first, the user

has to create a new exercise by creating domains, then the data needs to be inputted

and the domains filled up, and then some checks need to be carried out. In the end, if

everything is faultless, the exercise needs to be delivered to the Ground machine, which

finally distributes it on all the platform machines. Then the exercise can be started.

In order to create a new exercise, the first step is to create a new ‘folder’ of domains

where all the data is going to go. This is the exercise DATASET. And it consists of five

domains. Each of the domains holds data for a different part of an exercise. These five

domains include:

• Airspace – includes all the points, airports, volumes, sectors, airways, SIDs, STARs;

• Traffic Sample – all the flights and their data are stored there,

• Constraints – sometimes it can be useful to create constraints for your exercise,
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• Architecture – the composition of controller and pilot positions, as well as simu-

lation area radar equipment and conflict warning architecture,

• Meteorological Environment – enables to set meteorological conditions for the

exercise.

The domain that always has to be created first is the Airspace domain. It is the root

domain, and all the other domains are then linked to this one. It is essential to keep

this in mind while creating the other domains because it is impossible to create a new

exercise without the link between them. However, more instances of a single domain can

be linked to an Airspace domain (for example, there can be one Airspace domain with

multiple different Traffic Samples linked to it, then there can be a different exercise for

each of the traffic samples). Also, note that all five domains have to be included, even if

they are planned to remain empty (although some cannot remain empty in any case).

After the domain set (Airspace domain + 4 affiliated domains) is ready, an exercise may

be created. To create fictional airspace, the process of building an exercise can also be

done to a certain extent by importing pre-prepared data. Without the help of the im-

port function, a user can start building an exercise just inside of IPAS. It is considered

hard because IPAS is not explicitly made for creating an exercise ‘from scratch’, but it

can be done. After all, that is how the most of currently existing exercises at the DoAT

were made. The advantage of this is that the user’s imagination and creativity is the limit.

On the other hand, sometimes the precision needed (for example in terms of precise point

location and sectors outlines design while designing the exercise airspace) is not easily

achievable with only the IPAS utilities. Thus, there is an opportunity to program new

tools that will help create the needed data and easily import them into IPAS.

At the moment, an exercise designer has to literally copy desired coordinates on the paper

and then manually input them into the IPAS. The workaround is to use external tools

(Excel seems to be a handy tool in pre-preparing the data), or tools included in IPAS.

Alternatively, the user can use some existing tools on the internet that can be adjusted
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for data creation needs. Those are maybe not made explicitly for this particular purpose

but will work. Some of them will be mentioned later in this chapter.

The most important basic principles of IPAS data management will now be described.

The fundamental fact the user has to know is that all the exercise data is stored inside an

SQL database while working with IPAS. With all the various cross-checks in place, it is

generally impossible to introduce a wrong entry into the exercise, as IPAS always lets the

user know about the error sooner or later. However, error managing and debugging can

sometimes be stressful or not straightforward. It is recommended to correct any mistake

right after the announcement, or one by one if there is a list.

Firstly, see picture 5.1. There are 10 most important buttons of the data input interface

that are used for accessing the database on the IPAS machine. The user will encounter

these every time any domain is opened (done by clicking ‘Jump to’ next to the respective

domain in the root IPAS window).

Figure 5.1: Data input top toolbar

1. Modify selected records: Opens an ‘Edit a record’ window of the selected item.

This is how the user edits a database record. To create a new one, see number 3.

2. Duplicate selected record: Clicking this button, a similar window to the one

described above is opened. There, the user can modify the future duplicated record.

The same rules apply.

3. Add a new record: Used to create a new blank record with no data filled in

yet. In the opened window, every cell with orange shading needs to be filled in, the

others are optional (but often needed too, as the software would tell the user if not

filled correctly).
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4. Delete selected records: This button will erase selected records from the database.

Until the ‘Commit database’ button is pressed, the erased records are still recover-

able by clicking ‘Rollback database’. It can be thought of as moving the record to

the trash and then empty it by commit, or restore it by rollback.

5. DetailBox on the selected record:5 Useful button for exploring all the con-

nections between the selected record and other domains or entries throughout the

database.

6. Refresh the list: Refreshes the database view in order to see any new changes if

they were made in another window.

7. Commit database: One of the most important buttons. In order to save any

changes to the database, the user has to commit, which means to save any changes

made since the last commit. After a commit is performed, the rollback button will

not work.

8. Rollback database: The rollback button will undo all the changes that were made

since the last commit.

9. Quit ...: Will close the data input window. It is the only way to close it because the

top-right cross button normally used for closing windows does not work. Similarly,

when editing a record, to exit, the user has to press the Cancel button in the bottom

right of the window and not the cross button at the top right as usual for every

graphical operating system. If there were any uncommitted changes, the software

will ask the user if the commit should be performed.

10. Help ...: Opens a document with some basic help related to the currently opened

window. It can be used to consult the input data format or the various tabs for

different objects.

As it was stated a few paragraphs back, there is sometimes precision needed during

exercise creation. In terms of precise aim for particular coordinates, some tools present in

IPAS can be used. The first one is ‘rb calculation’ that is started by navigating into SID
5Works only in the Airspace domain.
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or STAR tab of the Airspace data input window and clicking Specific functionalities →

SID/STAR → rb calculation. This tool is a precise distance and points calculation tool.

According to a given reference point, it can calculate distance or an intersection between

two points, or prepare a near-circular set of points (in order to create a circular volume).

Figure 5.2: IPAS rb calculation tool (source: author’s screenshot of the simulator)

However, the points need to be manually inserted into this tool by their coordinates.

The coordinates have a different format than usually in IPAS data input – namely

DDMMSS(N/S) for latitude and DDDMMSS(W/E) for longitude, where D stands for

degrees, M for minutes and S for seconds of arc. Luckily, the calculated points can then

be exported to IPAS by Create points button, which will transfer them straight into GEO

POINTS tab of Airspace data input window.

The second tool mentioned is the intersection tool. It is launched from IPAS ART VISU

function, by navigating into Airspace → Points → Intersection. Compared to rb cal-

culation tool, it enables to precisely aim for a desired point on the map (the graphic
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preparation window) by clicking into a P field of the intersection tool, and then middle-

click onto the desired location on the map – the precise coordinations will display in the

field. On the other hand, there is no exporting feature. That means these coordinates

need to be copied into the data input manually. The original purpose of this tool is – as

the name suggests – to find an intersection between two defined lines (each defined by

two points). That can be useful for a designer, too.

Figure 5.3: Intersection tool (source: author’s screenshot of the simulator)

Now the thesis will go into details of all of the domains that can be assessed in IPAS.

Some tips are provided for better orientation of a user in the data input. However, the

majority of the elements are intuitive for someone familiar with the ATM environment.

5.1 Airspace

Airspace is the basic domain of the set. Its purpose is to hold the data of the airspace

and environment in terms of how the airspace generally looks on the aviation charts in

real life – meaning points, volumes, routes etc. Some of the most important tabs in the

Airspace data input window should be described in more detail. The software will guide

the user if anything is filled in incorrectly or missing. The basic rule is to fill in all the

fields that have an orange background. In case of struggling with some basic things how

to edit any data in data input, a user can consult the help function that is described

under the toolbar figure (Figure 5.1), item 10. Every field will show a little tooltip when

it is hovered on for a while with the mouse.

77



Faculty of Transportation Sciences
Czech Technical University in Prague

• GEO POINTS – here, the dataset of all points used in the exercise is stored. The

principle is simple: it needs just a name of the point and the coordinates. It is

important to note the format of the coordinates in this case, for latitude, the format

is DD MM (N/S) SS, and DDD MM (W/E) SS for longitude. This format

is the most common used almost throughout the whole IPAS. The points created

serve as the source data for creating other elements of the airspace. The points must

be already prepared before creating any other element like Airport, SID, STAR, or

others.

• AIRPORTS, AIRWAYS, SIDS, STARS – these elements are created in the

airspace by referencing the points created in the GEO POINTS tab. A SID (Stan-

dard Instrument Departure Route) should include the runway threshold point as

the first point of the SID. The last point should be the first point of the adjacent

en-route airway. An important finding to share regarding STARs, for correct brak-

ing of the aircraft, the last but one point of the STAR is the point where the aircraft

starts braking, if the point is set as FINAL in the Approach phase field.

• VOLUMES – this is the basic unit of airspace that is consequentially used to create

a sector. Volumes, defined by points, bottom level and top level, have to fill the

whole simulation area in result. If it is not filled correctly, an error will occur in

terms of a hole, non-common areas or overlaps.

• HOLDING STACKS – defines a holding pattern in airspace by a reference point,

orientation and leg definition. If later the aircraft is assigned the point in its path,

it will enter the holding pattern unless instructed otherwise by the pilot position.

• SECTORS – Composed of volumes, sectors are the most important critical of

airspace, and also for ESCAPE. Each of the sectors has its ATC centre, assigned

controller, pilot, frequency.

5.2 Traffic Sample

In the traffic sample, all the data concerning aircraft is located. When creating a new

record of a flight, there are several things to consider. The start time of the first aircraft
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should more or less follow the start time of the exercise, otherwise, there will be nothing

happening at the beginning of the exercise when it is run. Again, all the fields in orange

have to be filled in in order to save a record correctly.

For the Datalink flights – the second tab of the traffic sample window, a flight has to

have its ‘Datalink equipment’ set. Then, flight referencing records can be created in

the Datalink flights tab. That should theoretically tell the system that these flights are

datalink capable and turn on the components in the simulator. However, this has not

been successfully used at the Department, although some initial tries were performed.

5.3 Constraints

This has not been much explored function of ESCAPE at the Department yet. It is known

that it is used for modelling proper 3D trajectories of flights and therefore at least one

constraint has to be defined. More constraints can set particular levels on specific points

of a descend path that a flight will follow on approach. Because DoAT exercises presume

a total control of a controller, this has not been much used. In the future, for the projects

and case studies, this will be a needed feature of ESCAPE.

5.4 Architecture

This is a significant domain, as it sets how many controllers and pseudo-pilots will be

present and working during the exercise. This is directly dependent on the state of the

platform the user can use. That means that if the platform consists of a CWP machine

and a PWP machine, it is logical to include one (executive) controller and one pilot in

the architecture domain. Another controller (FEED_HYBRID) will act as a supervisor

and will be run on Ground.

A rule of a thumb states that executive controllers should begin with number 1...9, poten-

tial planning controllers should be respective numbers in the ten or twenty region (10...19

or 20...29), the FEED_HYBRID supervisor positions should range in the thirty range

(31...39). This is only to keep order in the positions. Pilots should start from number 1.
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Therefore, the classic DoAT architecture consists of an executive controller (1), FEED_HY-

BRID (31) and a pilot (1) positions. In bigger platforms, the numbers should be assigned

correspondingly. Another thing that is important to follow is the ORGanization and Lay-

out mentioned in chapters 3.1.4 and 3.1.5, especially the figure 3.7.

The other tabs of the Architecture domain are described below. Among the CWP and

PWP arrangement, the STCA and MTCD areas, surveillance coverage and software cen-

tres are set there.

• SURVEILLANCE COVERAGE – It has to cover the whole simulation area; there-

fore, it is generally set for the simulation area volume. The error rate of surveillance

and detection probability can be set, too.

• SOFTWARE CENTRES – Same as the surveillance coverage, it is generally set to

the whole simulation area, and the required ATC CENTRES are affiliated to the

software centre, as well as the coverage area.

• STCA and MTCD AREAS – thresholds, margins and effect areas can be set for the

areas.

5.5 Meteorological Environment

The basic meteorological parameters (namely sea-level temperature, wind heading and

speed, and speed of sound) can be set inside the last described domain from the set. In

the METEO PARAMETERS tab, there are the details for the whole airspace that will be

in effect for the whole course in the exercise. Setting wind will cause drift in aircraft paths.

In the FORECAST METEOS tab, separate meteorological forecasts can be defined for a

specific volume, activation time and level. This functionality has not yet been carefully

tested with the ESCAPE team at DoAT.
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5.6 Importing Data

Having the domains all covered, the importing data function will be mentioned in this

sub-chapter for the next part of the thesis. If a user intends to import data created with

another tool outside of ESCAPE, a few considerations have to be taken into account. It

is always useful to export a sample (no matter if empty) data with the help of the IPAS

Export function because it will provide a complete overview of how the data should look

to be successfully imported. IPAS will only accept the data in a specific format.

The main problem with imports is the absence of continuous checking for errors a user

would get if the records were inputted one by one into the database. For that reason, the

log after importing must be checked for a list of records not imported. Then the list of

errors has to be consulted to get why the records were not imported. The imported file

then has to be edited, or the existing database in IPAS adjusted accordingly.

To transfer data from another source into IPAS, the data needs to be adjusted to the

correct format accordingly. The most useful in this regard is Microsoft Excel, as even a

relatively simple sheet can be a big help. One of the main problems to solve – at least for

points records – is usually to convert the most used coordinates formats (decimal degrees

or DMS/DMM formats with the hemisphere N/S/W/E at the end of the figure) correctly

into the format IPAS and ESCAPE take into account (DD MM N/E SS). After that, the

columns need to be correctly ordered – according to the scheme of previously exported

same type of data.

In conclusion, the future of ESCAPE at DoAT asks for a tool that would be flexible in

preparing data for importing into IPAS. This could be included in the topics that are

useful to look into, in terms of further deployment of ESCAPE Light at DoAT.
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6 Potential Use of the Simulator at Department

One of the thesis targets is to define a vision of the potential use of ESCAPE at the

Department of Air Transport. Specifically, it was anticipated that each of the Depart-

ment’s laboratories might have a potential for applying some of their science and research

case studies on the simulator platform and use it as a tool to prove hypotheses, try their

concepts, etc. There are currently four laboratories at DoAT. Each of them consists of

a team of experts in their field. The laboratory and its equipment serve as a workplace

to support the science and research activities conducted in each laboratory. The output

is frequently a highly recognised research or science article included in renowned publica-

tions or Scopus or Web of Science databases.

Adjacent to the laboratories, there are so-called projects. They’re dedicated to support

and prop up education at the Department, while solving tasks and case studies that are

desirable for the laboratory on a bigger scale, or for finding a suitable topic for a stu-

dent’s thesis. Some projects are not adjacent to any laboratory and act as a stand-alone

subject, dealing with the things mentioned. For a better overview, a figure 6.1 shows all

the projects and adjacent laboratories where applicable.

For the purpose of this thesis, each of the laboratories was approached. In terms of stand-

alone projects, the law and economics project is considered non-related to the simulator

capabilities. Hence it was not described in the following subchapters, and neither was

the aircraft maintenance field of research that is under the merit of safety and security

laboratory.

The methodologies are described in the following subsections. The European methodology

is introduced as a recommended style of validation of ATM concepts. This methodology

was used as a template for creating the author’s approach, which shows how to assess the

laboratory and projects consultations concerning the simulator capabilities and possible

improvements.
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Figure 6.1: Laboratories and their adjacent projects at the Department (source: author’s

figure based on [28])

6.1 European Operational Concept Validation Methodology

The European Operational Concept Validation Methodology (E-OCVM) is a document

that helps with the validation and verification process of anticipated ATM concepts. It

was made for project managers, system developers or validation practitioners who oper-

ate in the ATM research and development sphere. This methodology has been applied to

form the definition of ESCAPE future projects that are feasible to conduct in the short

to medium term at the DoAT.

According to the methodology[29], there are eight phases of an operational concept. They

are symbolised by ‘V’, although sometimes they are known as ‘Technological Readiness

Levels’ (TLRs) – that is used by NASA, for example. As it can be seen in the figure 6.2,

only phases V1-3 are in the scope of E-OVCM. The adjacent phases are in concern too,

as V0 is needed to ensure that the proposed system has met the correct initial conditions,

and there has to be a proper understanding between phases V3 and V4.
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Figure 6.2: E-OCVM V-phases (source: Figure 2 of [29])

Firstly, the initial identification of ATM needs is needed in V0. These requirements are

consequentially used in order to define the operational or technical solutions in phase

V1. The definition should be quite detailed, as in V2, the feasibility study is performed.

That should find out if the concepts are genuinely feasible, or are not much meaningful

to further develop. If they are feasible, the V3 phase takes place.

During the V3 phase, the operational concepts are refined to transition from research to

real operations. Sometimes, real-time simulations can be used, so that successful inte-

gration of the concept can be completed at the end. The industrialisation phase ensures

that, if needed, proper regulation will be developed for the concept. The concept is then

deployed in the fifth V-phase. The systems for this concept are build, installed and vali-

dated throughout the deployment target locations. After the infrastructure is ready and

the concept is deployed, the V6 phase takes place. According to all set regulations and

enablers, the concept (now service or product) is continuously used by users, and the

benefits can be measured. This phase does not end until the last V-phase – decommis-

sioning, when the service is overdue and a new evolution is about to take over. With the

incoming concept, the process should more or less happen in the same manner following

this methodology.[29]

While forming the vision of the future deployment of ESCAPE at the Department, not

all phases from the E-OCVM can be correlated literally to the author’s method phases.
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6.2 Author’s Method

The potential of the ESCAPE Light simulator is not only for its educational capabilities

but also lies in its possible deployment for research activities at the university. Until

now, there has not been any comparable tool available for the researchers to simulate and

validate processes within ATM. One of the thesis key objectives is to identify possible re-

search questions that could be analysed through the ESCAPE Light simulator. The first

step was to identify all the simulator features that could be used for education, science

and research, and could be interesting for the laboratories managers and other leading

personnel. This phase was done by the previous part of the thesis, where ESCAPE and

its features anthology were described.

From there on, the author’s approach to the problem is partly derived from the E-OCVM

concept. Phase V0 can be seen as the identification of the needs of the laboratories and

project managers. They were interviewed and spoken to in order to interconnect the sim-

ulator’s features with their visions and requests. In other words – to define the scope and

the operational solutions, as in phase V1 of E-OCVM. After that, it should be identified

if those projects are feasible to implement with the aid of the simulator, and what will

the realisation look like in terms of simulator limitations, what enhancements will have

to be done and what costs are going to be present – similar to V2 phase of E-OCVM.

There is an analogy between V3–V6 phases of the E-OCVM and the author’s method

Realisation phase. However, this is the question of the actual future project selection and

realisation. The author’s approach can be seen in the figure below.

Ideally, this method should also help unify the requirements acquired, choose the most

desirable ones to have, and try to implement. If the author identifies that his knowledge

of the simulator is not enough for some of the requirements to be deployed, it is a matter

to consult with Eurocontrol and other institutions of the ESCAPE Light community.
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Figure 6.3: Method of approach

6.3 Education and Training

For a start, the fundamental part of university operations should be considered – edu-

cation. Following the newly approved accreditation, a new subject will be taught at the

Faculty. The ‘Air Traffic Control Operating Procedures’ (Postupy a činnosti ATC) elec-

tive subject of the summer semester will take place in the third year of bachelor studies

during the Air Transport course. As it was described in the 4.2, there is a set of exercises

ready to be used for this subject, and there are more continuously created.

For extending the education purposes, there is an opportunity for bachelor thesis topics in

the scope of project-oriented education at the DoAT. Students interested in ATC/ATM

will be encouraged to design, program and solve an operational (real-life) particular prob-

lem with the aid of ESCAPE Light.

Cooperation with radiocommunications or simple ATC simulators mentioned in chapter

2 would also account for a better level of education – in terms of interconnectedness,

practice and overall ATC skills. Despite every simulator having its separate subject, for

the upcoming years, it can be helpful to think about a specific subject concerning the sim-

ulations and simulators universally, as they are a phenomenon throughout aviation and

they are beginning to be truly developed at the DoAT, but not used enough in education.
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Since ESCAPE Light will be a part of the syllabus and more interest can be expected

in the future, it would be helpful to consider expanding the ESCAPE simulator platform

at the DoAT. Nowadays, a maximum of only four computers can be occupied simulta-

neously, which requires a considerable amount of time management, as the subjects can

have up to 30 students enrolled. That means that if a university exercise lesson takes 90

minutes, each student would spend only some 12 minutes on the simulator. That is too

little time to bring students the entire experience – from the already created ones, not

even the shortest ESCAPE exercise takes so little time. It has to be ensured that enough

time is given to each student during the practical training.

One option is to allocate space at the Department and include more computers in the

ESCAPE platform. However, the computers would probably not be used for any other

reason than the simulator. Another factor is the limited space at the Department. The

second option is to get in touch with the IT department of the Faculty and install ES-

CAPE in one of the computer classrooms (each has approximately 20 computers). Ideally,

one of the classrooms could include CWP positions and supervisors, the other one PWP

positions. It would be hard in terms of realisation, organisation and exercise design, and

maybe the ESCAPE Light would not even be enough for such a big platform.

According to the consultation with the head of DoAT, the Department has recently been

considering options of becoming an ATCO training organisation in the future as it already

holds certificates for Approved Training Organization (CZ/ATO - 010) for the training

of professional pilots, and Maintenance Training Organization (CZ.147.0004) for B1 and

B2 class aviation maintenance workers. The ATCO training organisation could be put

into operation with help or cooperation with other subjects in the field. There may also

soon be a branch of a Danish ATCO training organisation called GATE Aviation in the

Czech Republic.[30] As they possess a high-level 2D simulator for a controller, pseudo-

pilot position and a 3D tower simulator, they could be a great partner for the Department

of Air Transport.
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6.4 Science and Research

As stated earlier, simulations and mainly the ESCAPE simulator have the potential to

create an environment that will enable researchers to address science and research ques-

tions or hypotheses and support students in their work on bachelor and master theses.

The author has investigated the needs and possible case studies initiations of laboratories

and research project areas at the Department of Air Transport by consultation with their

respective managers and representatives. This part of the thesis shall now induce possible

areas for future deployment of the simulator for research and educational purposes across

the DoAT.

The main limitation of academic research concerning the simulator is a lack of licensed

air traffic controllers – an appropriate sample for the research topics. Even if they were

present, it does not eliminate the distortion in the form of not being in their typical

environment, as the simulator’s conditions at the DoAT cannot fully resemble those at

an official Air Traffic Control. Despite those limits, it is still possible to model a broad

spectrum of research questions and case studies because not every ATC/ATM research is

conducted on ATCOs, but rather a typical population sample.

6.4.1 Laboratory of CNS/ATM Systems

As stated in the beginning, the home laboratory for the ESCAPE simulator, led by

Stanislav Pleninger, PhD, has been lately focused on the CNS sphere. The ESCAPE

simulator, therefore, enhances the portfolio of activities substantially.

There were multiple topics discussed during the consultation, many of which have not yet

been tried since the introduction of ESCAPE to the Department. Those topics could be

interesting for inducing future science and research topics, but also education in terms

of bachelor’s/master’s theses. For example, for creating custom exercises, it would be

useful to develop (program) a tool that would enable users to literally draw their required

airspace (including custom points, SIDs, STARs) by clicking into a map, and subsequently
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import these data into ESCAPE. Simply said – developing an ESCAPE compatible graph-

ical airspace creation tool.

The operations-related functions that have not yet been widely used by the DoAT ES-

CAPE team and were mentioned during the meeting with the CNS/ATM Systems Lab-

oratory are included in the table below:

• GLS/ILS approach comparison with focus on workload (so far only ILS approaches

were used because they have been working flawlessly and there was not any need to

change that),

• executive & planning controller relationship and architecture (there has not been

space nor other resources for implementing and introducing planning controller into

the architecture),

• sector-less concept (currently not known if it is even possible in the ESCAPE Light,

future concept),

• STCA and MTCD – conflict detection features (have not yet been much used be-

cause it is not desirable to bother students in the exercises with many notices, it is

better to be consulted after the exercise during logs and recordings assessment),

• automatic updating of AIRAC, AIP (subject to further investigation, but it is sus-

pected ESCAPE Light is not capable of doing that, because of several license limi-

tations),

• CPDLC and datalink in general (possibility to look into these functions and how to

properly enable them and fully use them).

There has also been an interest in connecting ESCAPE with radiocommunication and

simple ATC simulators at the Faculty, as this connection could potentially help pilot

training in terms of proper communication and more realistic overall ATC simulation.
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6.4.2 Air Transport Operations Laboratory

As the Laboratory of Air Transport Operations (led by Assoc. Prof. Jakub Hospodka)

is the main operator of A320 and Beechcraft simulators (see chapter 2) at DoAT, there

is primarily a high potential for connecting one or both simulators to ESCAPE, as they

could feed data into the ATC simulator. In practice, that could look like a target on the

radar. This target would be steered by a pseudo-pilot, sitting in the A320/Beechcraft

simulator.

This is known to be possible thanks to the ESCAPE architecture. For proper connection

between another simulator and ESCAPE, a proper linking element has to be programmed.

It should primarily be done in C++ language as this is the core of the ESCAPE architec-

ture. The dataflows between the simulators should be ensured by a particularly designed

component (CDL file). Eurocontrol offers a 4-day course tutorial on programming these

components. However attractive the interconnection idea is, it is not the priority for the

Laboratory.

The voice communication between an ESCAPE controller and the pilot of the other

simulator could also be established. If the controller is qualified enough, it would serve

as a great near-reality element of the pilot’s training. Some ESCAPE exercises could be

developed especially for pilot training (elaborated pilot log, challenging procedures etc.).

6.4.3 Aviation Safety and Security Laboratory

The safety laboratory led by Assoc. Prof. Andrej Lališ mainly concentrates on three fields

of study. These are introduced below to understand the context and possible scope of

cooperation between the laboratory and the simulator. These fields of study can be either

partially or fully considered for cooperation in terms of validation and modelling of a

particular research question on the simulator. This issue may impact the safety operation

or processes in general, or in companies or institutions (e.g. Civil Aviation Authorities,

Air Traffic Control Services, airports etc.).
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Here is the list of safety-related fields of study. Note that the laboratory also does security

(not listed here because it is not feasible to simulate any kind of security matters).

1. Safety evaluation of new aviation products (systems, procedures, training etc.)

2. Aviation accident and incident investigation

3. Aviation safety management systems, their setup and operation

ad (1.) Either a new aviation product is evaluated and its safety estimated, or the safest

option is chosen out of several items. In the simulator, it would be possible to test

this newly developed or applied item in real airspace. It would also be possible

to simulate interaction between two functions, define risks, hazards and corrective

measures. Moreover, this testing would be used as one of the important inputs for

hazard identification and risk assessment.

ad (2.) As it is basically impossible to fully reconstruct an incident/accident, the simulator

could test specific measures that come as a follow-up of some accident investigation.

However, the simulator could partially reconstruct a particular issue that cannot be

well understood from actual accident data and provide some insight. The laboratory

would learn more about some specific interaction or phenomena.

ad (3.) In case there is an ATC-related problem identified inside a Safety Management

System, there would be a possibility to determine a hypothesis that could be tested

in a specific controlled experiment in the simulator that would have to be projected

and organised.

These three main fields of study show that the laboratory does not generate its own case

studies but rather reflects and evaluates operational developments in the industry, as well

as research activities on DoAT that require safety assessment. In conclusion, if the ATM

laboratory or the team provided a proper simulated topic or problem, it would not be an

issue. The topics can range from implementation of a different standard routes operations,

or automation add-on tool, to ATC radar colour scheme change, etc.
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The use of logs and recording of exercises (as described in chapter A.5) would be useful

in the laboratory’s possible research topics connected with the simulator. The main

output of the research of the specific logs could include confirmation or rejection of various

hypotheses set at the beginning of the research. Another functionality that could be used

in the assessment is custom MAPS graphic representation. Outside of the simulator

interface, there is a possibility to record the exercise in terms of screen capture or voice

recordings that can be paired to the logs and radar playbacks provided by the simulator.

6.4.4 Laboratory of Human Factors and Automation in Aviation

The Laboratory of Human Factors and Automation in Aviation (HFAA Lab for short),

led by Assoc. Prof. Vladimír Socha, is a reputable laboratory of the DoAT. Their re-

search topics – as the name suggests – cover mostly physiological data oriented topics

related to aviation and aviation specialists (pilots, ATCOs, maintenance). Specialised

software analysing these data is also a strong domain of the laboratory, most frequently

programmed in Matlab for a specific application of the study. For example, the data can

be used to develop systems for reaction time assessment based on brain activity (measured

by EEG – electroencephalogram), heart rate (measured by ECG – electrocardiogram) and

blood pressure. Another significant domain of the laboratory is the research of vestibular

illusions[31], or fatigue, eye-tracking, stress, etc. All these phenomenons could also be

tested in cooperation with the ESCAPE simulator.

Concerning the EEG/ECG measurements, there were already a few measuring sessions

conducted on the ESCAPE simulator during spring/summer 2021. It was a part of re-

search for multiple bachelor and master theses of the laboratory, where moderately trained

subjects (mostly students) were tested while undergoing a challenging exercise (high traf-

fic load, a lot of communication, almost two hours long). Brain activity and heart rate

was measured at approximately 20 subjects, using a university-developed system called

FlexiGuard[32]. The idea is to induce more of these experiments because human factors

play a significant role throughout ATM. Along with new technologies developed in this

area, there are a lot of emerging topics that could be solved with the aid of ESCAPE.
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The everlasting limitation for science and research in this scope is that the tested sub-

ject will rarely be a licensed ATCO, as the research is conducted on university grounds.

Even if the ATCOs took part in the experiment, the research would be distorted by them

not being in their ‘natural habitat’. In other words, ESCAPE is not precisely the same

software and environment they encounter in their work every day. A solution to this may

be to create a group of students who have been interested in ATC for a long time and

therefore possess the skills needed to be subject to testing. Despite lowering the data

validity, with a reasonable sample of subjects, the limitation can be slightly mitigated.

Another option is to have a small stable pool of ATCOs available for experiments. This

option is quite questionable because the ATCOs are quite a valuable resource.

For future potential use, there are many possibilities for engaging the HFAA Lab in coop-

eration with ESCAPE. The first area might concern creating a set of high load exercises

that would enable measuring EEG, ECG and other physiological and biomedical data.

Workload, reaction time, stress and others may then be assessed. The exercises difficulty

could also be adjusted with the help of Task Load Index (developed by Ames Research

Center of NASA[33]) performed after every run. The same tool (Task Load Index) could

also compare subjects’ subjective perception of the exercise with the actual EEG/ECG

data.

Another area to research is the study of cognitive functions. These may include memory,

attention, concentration, working with information, emotional self-regulation, speech and

orientation in space. Nevertheless, specific exercises for that matter would have to be

developed with a focus on these functions. For example, designing tricky airspace, similar

callsigns, simulating faulty radar equipment, or comparable features might help the inten-

tion. To some extent, some of the performing students in these exercises might consider

the official ATCO job admissions. Alternatively, only the qualities/characteristics could

be assessed in terms of being suitable or fitting for the job in general or not. More topics

in terms of operations could include weather impact on workload, strip/strip-less control.
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The experience acquired by the measuring sessions during spring/summer 2021 described

above can be used to improve the level of this kind of research, exercise preparation, and

data collection methods. More precisely, there is a need for advanced recording tools

integrated into the simulator, as only ESCAPE unrelated external commercial software

like Discord or OBS were used to enable the headset communication and screen recording.

At this time, the complete logs with all the 4D trajectories of all concerned aircraft and

all the controller’s or pilot’s inputs into the simulation exercise can be acquired from ES-

CAPE. The logs can be further processed inside the SAT tool that is a part of the Ground

machine.

There is also a big project concerning a biofeedback simulator on a Boeing 737 aircraft

simulator with virtual reality capability. By means of it, the laboratory would like to

aim for further research of vestibular illusions. According to both the laboratory repre-

sentatives and the author of this thesis, there is also an incentive to connect the aircraft

simulator to ESCAPE in the future, which will take a lot of effort from both the teams

and Eurocontrol support, but it is possible – there is already a simulator of a similar kind

in EEC in Brétigny.

One of the features of the B737 VR biofeedback simulator is an eye-tracking headset. It

could be interesting to use it on ESCAPE to measure the amount of time the controller

spends searching the correct aircraft callsign and the controller’s overall scanning ability

of the airspace.

The laboratory representatives would also like to integrate the biofeedback simulator into

the training of pilots. This is a mutual idea of the HFAA Lab and CNS/ATM Laboratory,

as an initiative to integrate the ESCAPE simulator into the training of pilots and ATCOs

exists, too. It is, though, rather a long term vision.
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6.4.5 Unmanned Aircraft Systems Project

One of the projects of the Department is dealing with Unmanned Aircraft Systems (UAS).

As probably the youngest type of aircraft to exist, elaboration of operations concept of

airspace including UAS has been ongoing. That is why simulations could help in this

matter.

However, the U-Space – which is a European Union vision that should introduce pro-

cedures and services to support safe, efficient, and secure airspace for many UAS – is

not easy to simulate, nor it is easy to introduce. That does not discourage researchers

from keeping on working towards doing it, while UAS are getting more automated and

connected.

The UAS are supposed to generally move inside of what is called Very Low Level airspace

(VLL). This part of airspace is not usually widely simulated, but it is not empty, as the

civil and general aviation or HEMS (Helicopter Emergency Medical Service) are taking

off or landing through the airspace.

This follows a SESAR project marked PJ34, or AURA. It lays the foundation for new sub-

jects entering the U-Space environment (for example, the drone operators), so that they

are compliant with the requirements. The result should be harmonised, safe, sustainable

and efficient U-Space environment that complies with the current ATM environment.[34]

6.4.6 Modern Trends and Development of Airports Project

Air Traffic Management does not only consider airways. The airports are important nodes

in the management and airspace in general. Congestion and delays at the airport will be

transferred to the whole network. Even here, the need for simulations is located.

Eurocontrol – as the major player in realistic simulations – may help with that, too. Apart

from ESCAPE, similar simulation tools are specifically oriented towards airports, i.e. for

simulations of tower, arrivals, departures, slots, and stand allocation. For example, there

is an advanced Integrated Tower Working Position (ITWP) in works in Eurocontrol. It is
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a digital tower simulator that – in comparison to an ordinary tower environment – unifies

all the data and show it all on an advanced human-machine interface (HMI).[35]

Concerning Eurocontrol, their digital tower simulator software that can be connected to

ESCAPE, could be an interesting product for the Modern Trends and Development of

Airports Project, and an addition for the ESCAPE team. With ESCAPE alone, the

ESCAPE team at the Department is currently working on real Prague airspace model

inside of the simulator. The airport could be incorporated into the model with help of

some of the other Eurocontrol simulation tools.

6.5 Cooperation

While working on the thesis, it has become apparent that it will be important and useful

to create multi-laboratory/project cooperation teams inside of DoAT to solve difficult or

extensive projects with the simulator spanning over multiple subjects. The cooperation

could also work at the Faculty of Transportation Sciences and throughout the whole Czech

Technical University. For example, getting help from the Faculty of Electrical Engineering

or the Faculty of Information Technology would help solve some of the case studies or

problems, e.g. help with programming. One of the main joint projects could research a

possibility of creating a single multi-simulation platform that could be composed of an

ATC simulator, flight simulators, and others.

With the current initiative at DoAT to create these inter-laboratory teams following ex-

isting projects and laboratories[28], it would be desirable to engage these teams in more

extensive projects and initiatives that the ESCAPE simulator offers. In the figure 6.1, the

overview of all the laboratories and projects can be seen. For the cooperation teams, those

can be freely combined to create a specific inter-laboratory or inter-project cooperation.
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7 Realisation and Practicability

In the previous chapters, the outputs from the consultations with laboratories and projects

were interpreted. In this chapter, a summary of the interpretation will take place in the

form of a non-exhaustive list of possible steps, topics and actions that may be worked on

in the future. The tables on the pages below summarize feasible topics both mentioned

briefly and in detail throughout the whole thesis, but mainly in the chapter 6. They also

give out all the requirements, purpose and practicability of the proposed topics to start

the respective projects.

The tables are arranged to differentiate general improvements to the simulator from the

possible projects for both education and training, and specific topics for science and re-

search. Sometimes the topics from these areas overlap; therefore, they are stated only in

the most appropriate area for the topic.

The pattern in the tables states the overall category of topics, then states requirements

that must be done as prerequisites. The purpose states why the project is useful to carry

out, and the sources give out a list of links and references in order to find more informa-

tion about the subject – either in this thesis or externally.

The ESCAPE Light is a functioning product. In terms of costs, the most significant one

will be the person-hours. They will be required to work on the deployment and possible

projects, modify the software to the Department’s needs, and train more ESCAPE Light

qualified people. Other costs (financial) will include buying new computers, if the De-

partment chooses to expand the platform in the future, for example.

The practicability scale is presented below as a measure of how challenging it is for a

project to be carried out. The respective colors are then used for every project in the

tables below. There will always be a regular amount of the above-mentioned person-hours

required for creating an exercise or spend time with the specific settings that have already

been explored before, but those are not concerned. The practicability scale shall show
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presence of new unexplored settings and features that will require more time and effort

to grasp and learn. Moreover, some other costs or constraints might be present.

Figure 7.1: Practicability scale (source: author)

It can be interpreted as following:

• Realizable section of the scale means the project could be carried out with minimal

preparations and within short time frame.

• With minimal modifications – more insight and time is required to assess and prepare

the functions needed for the project.

• Dependent on other projects – cannot be completed until some of the other proposed

projects are completed beforehand.

• With significant modifications – much more insight and time is required, usually

including deep Eurocontrol coordination, or considerable amount of person-hours.

• Hardly realizable – cannot be completed for reasons like limitations of the license;

or being a really long term project with a significant amount of person-hours.

98



Faculty
ofTransportation

Sciences
C
zech

TechnicalU
niversity

in
P
rague

Table 7.1: Table of possible projects – General improvements

Topic Requirements Purpose Practicability

Expanding the simulator platform
• Finding physical space for the platform.

• Installing more machines on separate computers.

• Connecting all the computers.

Bigger platform, greater capabilities, larger simula-

tions and exercises. Useful mainly for education, but

also training, and bigger research projects.

Spatial and IT constraints.

New Simulation(s) creation
• SQL and Python knowledge.

• Eurocontrol Consultation.

• Lot of work maintaining order in multiple simulations.

Diverse exercise sets might be designed in a separate

simulation while not interfering with settings of the

other ones. Currently, every exercise at DoAT uses

the same database (UNISCAPE) that has to use a

single MAPS, Layout and settings in general, which

is not very flexible.

Extensive Eurocontrol coordina-

tion. Extra person-hours for defin-

ing and maintaining order in simu-

lations.

Data preparation tools development
• Programming skills.

• IPAS data importing structure knowledge.

• Flexible and easy to use concept in mind.

Maintaining easy transfer of data between external

sources (like AIP, other simulators or completely cus-

tom). Ideally an elaborated Excel file or Python ap-

plication that would flexibly convert custom data to

IPAS compliant data. Also a tool for drawing out

custom airspace would vastly help to make fictional

airspace exercise creation more efficient.

Only limited by a specific idea of

the tool design.

Multi-simulation platform

• Identifying the simulators that are wanted to be connected

and the scale of connection.

• Programming skills for possible simulators data exchange

connection – CDL component file programming.

• Deep understanding of both ESCAPE and the other

simulator(s) to be possibly connected.

• Defining and identifying inputs and outputs of the

simulators.

The ultimate simulation tool for education, training,

science and research. Great potential of creating a

unique platform(s). The simulators that could poten-

tially be connected to ESCAPE are: biofeedback VR

simulator (section 6.4.4) and other simulators stated

in section 2

Eurocontrol deep cooperation,

defining I/O, CDL programming
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Table 7.2: Table of possible projects – Yet unexplored features

Topic Requirements Purpose Practicability

Other controller functions

• Setting up an environment for multiple CWPs (including

installing more machines).

• Creating an exercise with architecture with different

controller functions (planning, assistant, flow, supervisor).

• Following all ORG, Layout rules and correlation in IPAS.

• Observing and comparing the functionalities of this set-up.

In order to discover the capabilities of different con-

troller functions and comparing multiple different ar-

rangements of controllers in various exercises.

More computers and bigger plat-

form required; otherwise realizable.

MTCD/STCA areas

• Creating MTCD area inside of the tab of Architecture

domain window of an exercise.

• Discovering the HMI representation of MTCD alerts

during the exercise.

Extending the alerting capabilities of the simulator.

STCA has already been explored and used, but it can

be combined with this project to deepen the knowl-

edge.

Knowledge about the functions is

satisfactory.

Volume conditions and Contraints

• Creating volume condition(s) in the tab of Airspace

domain of an exercise; contraint(s) in the Constraints domain.

• Exploring the representation of the change to the exercise,

comparing with/without implementation of this feature.

Better coordination in airports adjacent volumes and

overall vertical flight paths representation.

Some additional knowledge about

the settings and features required.

Non-controlled areas
• Creating non-controlled areas in the tab of Airspace

domain of an exercise.

Could potentially be used to simulate class G airspace

or integrating UAV into the airspace. Would help to

simulate restricted or prohibited areas.

With some testing could be imple-

mented straight into the SQUARE

exercise, for example.

Arrival manager (AMAN) • Studying of how to enable AMAN in ESCAPE.

Interesting feature that could be added to arrival RLP

exercises and others in the future. Useful for manag-

ing the arrival aircraft and planning their approach

and landing sequence.

Some additional knowledge about

the functions required.

Datalink

• Creating records in the Datalink tab of Traffic Sample in

IPAS.

• Getting help from Eurocontrol on how to run the datalink

components properly.

Different approach to pseudopilot-aircraft controlling.

Also can be later used for HFAA Lab assessing higher

workload for a controller, but maybe a lower commu-

nication demand.

Putting CPDLC into operation was

not successful yet. Possible deep

Eurocontrol cooperation.
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Table 7.3: Table of possible projects – Education and training

Category Topic Requirements Purpose Practicability

T
h
eses

Prague and its surroundings – real

airspace representation/creation

• Creation of real airspace representation as it is from AIP.

• Efficient way of how to import the existing data.

As the first real airspace simulated for the

ESCAPE team at DoAT, the home environ-

ment creation could induce even more inter-

est in science and research, testing concepts

and hypotheses, from the side of DoAT, as

well as the Prague Airport or Air Navigation

Services.

Dependent upon the custom data

preparation tool development, vol-

ume conditions and constraints.

Also susceptible to many person-

hours.

Parallel runway operations
• Designing an airport with parallel runways in Airports tab

of Airspace.

• Choosing a suitable methodology for the subject – based

on ICAO Annex 14 (L14), Doc 9643, 4444, 8168.

Research of airspace capacity depending on

the use mode of the runways (one for DEP,

one for ARR; mixmode, ...)

Dependent upon the volume con-

ditions and constraints functions

working.

Adjacent airports influence on the

mutual airspace

• Management of higher amount of data.

• Many volumes constraints implementation.

• Trying to implement special procedures for aircraft.

Determine the bottleneck factors of multiple

adjacent airports in airspace, and try to de-

sign routes with minimal interference on ca-

pacity.

Same as above.

E
x
ercise

p
ortfolio

ex
ten

sion

Varying current exercises

• Copying current exercises and vary their contents, mainly

traffic sample.

• Using IPAS – adding traffic by ART VISU: Traffic →

Traffic Increase Facility function.

The exercises should not start being repeti-

tive for students over time. There should be

some innovation element after each semester

of education subjects. For the overall train-

ing framework, more types of exercises have

to be created in order to comply with the

Commission Regulation (EU) 2015/340[2]

The functions are ready to be used,

only a short testing required in or-

der to fine-tune it.

Creating new exercises based on lat-

est simulator improvements

• Following the DoAT ESCAPE Light platform updates and

improvements.

• Knowing how to implement the newly introduced features

into the exercise creation process.

Dependent upon the most recent

simulator improvements.

101



Faculty
ofTransportation

Sciences
C
zech

TechnicalU
niversity

in
P
rague

Table 7.4: Table of possible projects – Science and research

Category Topic Requirements Purpose Practicability

C
N
S
/A

T
M

S
y
stem

s

GLS/ILS Approach Comparison
• Changing equipment of a runway; approach option of a

traffic record.

For comparing the load of controller between

GLS/ILS approach. Also can serve as an

exploration of new feature and capability of

ESCAPE.

Creating a correct framework and

methodology, further knowledge of

the functions exhibition required.

Strip/strip-less traffic load
• Using exercises with strip/strip-less control.

• Possible option to use already created exercises, as they

possess the strip/strip-less ability.

Ability to assess the work-load of the con-

trollers, comparing strip/strip-less environ-

ment.

The educational exercises are ready

for strip/strip-less control. Other

more focused exercises may be ad-

ditionally created.

A
ir

T
ran

sp
ort

O
p
eration

s

Flight simulator connection

• Programming skills – CDL component file programming.

• Deep understanding of both ESCAPE and the other

simulator(s) to be connected.

• Defining and identifying inputs and outputs of the

simulators.

Flight simulator and ATC simulator connec-

tion could also serve as a great tool for pi-

lot training in terms of near-real ATC en-

counter.

Eurocontrol deep cooperation, CDL

programming workshop attendance

recommended

More options of audio communica-

tion

• Exploring more options of audio communication.

• Ability to record communication, multiple channels

capability.

• possibility to contact other members of the ESCAPE

community (f.e. André Tews from DLR) – ESCAPE specific

audio tool.

For possible simulators connection, a proper

multi-simulation audio communication tool

will be required. There is a possibility to join

the mutual TeamSpeak server, but the study

could show that the currently used Discord

feature will be enough.

TeamSpeak has been tried before,

but the connection could not be

achieved. It will require IT skills

and many person-hours to intro-

duce a reliable communication plat-

form.

Pilot training specific exercises

• Dependent on the simulator interconnection.

• Focus of the exercise has to be laid on the pilot, not a

controller.

• Elaborated pilot logs created, including challenging

procedures.

Helpful as an addition and real-like aspect of

pilot’s training curriculum.

Many person-hours and the simula-

tors interconnection dependence.

Traffic mix research

• Simulating many types of different traffic (cargo, military,

helicopter, ultra-light aircraft).

• Simulating landing procedures, time based or category

based separation between the traffix mix.

Helful for research of airspace where a high

number of types of aircraft occur frequently.

Specific exercises creation and traf-

fic mix aircraft types simulation.
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Table 7.5: Table of possible projects – Science and research (continuation)

Category Topic Requirements Purpose Practicability

H
F
A
A

Controller error rate under specific

conditions

• High traffic load exercises (one already created).

• Reliable physiological data sensor and data collection.

• Mastering of logs and recordings assessment (STORIA,

SAT).

• Proper coordination between the ESCAPE team and

HFAA lab.

Assessing of controller’s error rate during

high traffic load, temporary handicap or non-

standard situations modelled in the simula-

tor.

Enough experience gained dur-

ing previous measuring experiment.

Consider this minimal/significant

practicability, as the person-hours

can vary according to the complex-

ity of intended exercise.

General measuring exercises (physi-

ological, cognitive functions) with a

specific focus

Designing a set of exercises to measure a spe-

cific data (ECG, EEG, eye tracking, fatigue,

memory, attention etc.)

U
A
S

Class G and VLL airspace simula-

tion

• Exploring possible options of simulating VLL and class G

airspace.

• Using Non-controlled areas and volume conditions

comfortably.

• Introducing new performance models for UAV compatible

with ESCAPE.

In terms of U-Space, the simulations of

drones operations could be a valuable input

into further concept proving.

Not known if there is a potential

for drones simulation inside of ES-

CAPE. External tools and U-Space

AURA aid.

Point in Space (PinS) and HEMS

simulation

• Exploring possible options of simulating VLL and class G

airspace.

• Using Non-controlled areas and volume conditions

comfortably.

• Using helicopter BADA files.

For proving some of the concepts in this

sphere.

A lot of coordination and person-

hours because the helicopters are

not the usual kind of aircraft to sim-

ulate.

A
irp

orts

Initial Eurocontrol tower simulator

familiarization

• Acquiring a light version of the software, along with a

basic guidance.

• Trying to observe where how it could be connected to

ESCAPE.

As the second major Eurocontrol software

(that could be connected with ESCAPE), the

Department teams could get familiar with it,

use it, and hence expand the overall capabil-

ity to simulate, educate and perform science

and research.

Possible complications with acquir-

ing and implementing the simu-

lator successfully. Many screens

and powerful computers to accom-

modate it. Many person-hours to

grasp. Likely challenging to inter-

connect.

Runway capacity and throughput
• Look into the validity of RWY capacity research through

ESCAPE.

For testing one of the main airport capacity

parametres.

Currently not known if ESCAPE is

able to assist in RWY capacity cal-

culation and assessment.
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According to the feasible projects analysis, the general improvements to the simulator are

the most challenging to be realized. The reason is that the changes to the whole platform

have wide consequences to the future use of the simulator. Another trend visible in the

tables above is related to the education and training scope. Most of the analysed topics

are dependent on other features that will already have to be integrated by the time these

projects are carried out.

In the science and research sphere, the ATM/CNS proposed projects are based on rela-

tively researched features. The Air Transport Laboratory projects are challenging because

they are all dependent on the flight simulator connection to ESCAPE. Some additional

work would also be needed.

It was not possible to define topics for Aviation Safety and Security Laboratory because

the laboratory does not generate its own case studies and topics. The projects will have

to emerge from the most recent aviation industry operational developments, or research

activities of other laboratories that need safety assessment. A small project that could be

carried out is to extend the abilities of STORIA Analysis tool because extensive usage of

this tool in future Safety and Security Laboratory projects is expected.

The same is expected for the HFAA Lab. Furthermore, the proposed topics for this lab-

oratory are comparably practicable, as there has already been an exercise carried out on

ESCAPE while measuring the physiological functions of the subject. Therefore, it is only

needed to improve the coordination and common goals between the ESCAPE team at

DoAT and the HFAA Laboratory.

As the Unmanned Aircraft Systems (UAS) is not the usual kind of traffic to simulate

in ESCAPE, it will be harder to facilitate research of U-Space focused topics. Although

some of the frameworks like SESAR PJ34 project framework can be a valuable source, it

is needed to further coordinate the needs with Eurocontrol.
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For the airports project, a possible acquisition of tower simulator light version would

further enhance the simulation capabilities of the Department, including the ESCAPE

team, because the simulators can be connected. Runway throughput and capacity research

has to be first conducted in order to get the idea about ESCAPE representation of the

matter.
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8 Conclusion

The initial purpose of this thesis was to introduce an ATC simulator to a reader with little

or no previous experience with the simulator and present its functionalities, architecture,

features and interface. After simulations were described in general and aviation ones

presented, the focus shifted on two of the leading European institutions concerning air

traffic control officers, their training and – of course – ATC simulation. EASA is more of

a regulatory body, while Eurocontrol with its ECC is the leading player in the simulation

area.

That is why a simulator developed by Eurocontrol was the centre of focus of this thesis.

With the light version of the tool, the Department of Air Transport saw an opportunity

to implement the simulator into education, science and research. Despite ESCAPE not

being initially developed for universities, the author summarized basic to advanced pro-

cedures for the simulator control and administration. This resulted from his experience

with the simulator. In terms of the deployment, the author and the ESCAPE team at

DoAT are among the most advanced ESCAPE Light community members, along with

Zagreb University.

The ESCAPE simulator itself shows a considerable ability for ATM education improve-

ment at the Department. It also enriches practical proficiency in tailored exercises that

help students better grasp challenging procedures and processes of air traffic control and

management. For some, it provides insight into airspace design, too.

At the same time, the simulator brings opportunities for science and research questions.

Build upon consultations and requirements of the Department of Air Transport, the au-

thor has composed a set of topics that will serve as an outline and vision for future

deployment.

The envisioned topics can be researched at the Department by its laboratories, education

projects and theses. As complex as aviation is, the topics frequently cannot be handled in-
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dividually because they extend to multiple research areas. That asks for cooperation and

inter-connected teams at the Department and throughout the whole faculty or university.

With the ongoing process and development of the ESCAPE Light simulator at the Depart-

ment of Air Transport, the potential for a successful wider deployment is higher every day.
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Appendices

In the appendices, some of the sections are sourced from Eurocontrol-provided documents

and guides. However, they have been edited and restructured to suit the scope of the

thesis and particularly the ESCAPE platform at the Department of Air Transport. That

improved the usability and clarity of the below-mentioned guides. If a user needs any

additional info, the author of the thesis (or the ESCAPE team at the Department) should

be contacted, or the original internal documents consulted.
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Appendix A The Simulator’s Lifecycle – Brief User’s

Guide

This user’s guide should help a user to carry out a basic set of actions in terms of nav-

igating and running the simulator. It may not be fully exhaustive. For any additional

questions or help, you may contact the Department or the author of the thesis. Please

note that the passwords are provided only to the actual users of the simulator, and some

of the procedures may be changed if the platform was changed.

The first appendix provides a basic set of actions needed to administrate the simula-

tor throughout its lifecycle – from the power-up of the computers, creating an exercise,

running it and assessing it afterwards. Sometimes, help for dealing with frequently en-

countered errors is provided. Some of the actions are taken from an internal document

called ESCAPE Light Survival Kit that is courtesy of Philippe Bouchadon’s (ATM Sim-

ulator Specialist at Eurocontrol).

Sometimes, a user only needs to perform some of the tasks from the whole ‘lifecycle guide’.

That means the guide sections do not always start where the previous sections left off, if

they are read from start to end.

A.1 Starting the Simulator Machines

1. Sign into a Windows user.

Note: Pilot1, Controller1, Pilot2 and/or Controller2 are the current names of the

users on Windows.

2. Start the Oracle VM VirtualBox application. It should be located in the middle of

the desktop.

3. Start each of the desired machines by their names from the left column of the

VirtualBox window:

empgrd for ground machine,
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empcwp for a controller position,

emppil for a pilot position,

empipas for an IPAS session.

• empgrd needs some time to load up, you then proceed with signing in with the

Escape Simulator Account user

• empcwp and/or emppil does not need any other intervention from the user

• empipas needs some time to load up, you then proceed with signing in with

the IPAS Account user

A.2 Exercise Creation – Brief User’s Guide

This is a brief guide of how to create an exercise in IPAS. For the extent of this thesis, it

cannot be exhaustive as the procedures involved are too complex to be described in great

detail. For general information and basic step-by-step procedures, it is better to consult

the internal document[36].

A.2.1 Creating a Domain Set

In order to create a new exercise, the first step is to create a new ‘folder’ of domains

where all the data is going to go. That is done inside of the IPAS machine. Note that

the Airspace domain is the root domain, and all the other domains are affiliated to this

domain (see figure A.1)

Figure A.1: Exercise and domains relationship (source: author)
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1. Click DATASET on the left panel of IPAS window.

The domains window is now opened and it shows all the available created exer-

cises. Note: selecting an exercise or domain inside of the DATASET window is not

always working properly and sometimes it is necessary to push Num Lock or Caps

Lock button once before it can be clicked and the selection will turn orange,

which is required for modifying or editing.

2. By default, DATASET window opens with Exercises panel selected. When creat-

ing a entirely new exercise, proceed with selecting Domains panel by clicking the

Domains item at the top of the window (where it say ‘Display list of:’).

3. Select the AIRSPACE domain under Domain Name. It has to turn orange.

4. Select Edit → Create, at the top of the window.

5. Enter Airspace domain name and description (up to you).

6. Click Create.

7. Proceed with the following steps for every other domain (Traffic Sample, Constraint

Configuration, Architecture, Meteo Environment):

(a) Select a domain (make sure it is orange) and select Edit → Create, at the top

of the window.

(b) Enter domain name and do not forget to link it to the correct airspace!

(c) Click Create.

(d) Repeat for the remaining domains or proceed if all are created.

8. Click File → Validate.

Now that the domain set has been created, you can proceed with an exercise creation.
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A.2.2 Creating an Exercise

Creating an exercise from a domain set is described here. Note that the Start time of the

exercise will have to be considered when creating flights later on.

1. On the IPAS Machine, make sure the IPAS windows is opened.

2. Open DSET window by clicking the DATASET button on the left panel of the IPAS

window.

3. Click Edit → Create, at the top of the window.

4. In the ‘DATA SET Create Exercise’ window, fill in a name of the exercise, start

date, start time, description and select all the domains used by the exercise. START

WITH AIRSPACE ENVIRONMENT!

5. Click Create.

Now the exercise and its dataset can be opened and edited inside of the IPAS machine.

A.2.3 Duplication of Domain and/or Exercise

Note that if you want to copy an exercise, the step-by-step guide is similar as above, but

instead of selecting the Create option, you will need to Duplicate. Before you proceed,

think about what you will want to do with the duplicated exercise. It may not be intuitive

at first glance.

• Just the exercise may be duplicated. The domains will stay the same and any

change in any of the domains will project to BOTH exercises. This does not have

any practical use, apart from changing time or a date.

• Just a domain or multiple may be duplicated (this option does not apply to Airspace

domain).

– First, duplicate the domain of your choice and do not forget to link it to the

right (the same) airpace domain. A duplicated domain can be linked to the

same airspace while it is created.
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– Then, duplicate the exercise and change just the duplicated domain in the

exercise creation.

– Any change you will make in the airspace will project to BOTH exercises, but

the domain you’ve duplicated (and the new exercise consisting of the duplicate)

will be independent of each other.

• If the Airspace domain is duplicated, all the other domains have to be newly created,

because one domain cannot be affiliated to multiple airspace domains.

A.2.4 Data Creation

With the help of this thesis, some other documents provided by Eurocontrol, and some

basic user knowledge of computers, a user should be able to input data into the system

according to the intended design. The process is briefly as follows:

1. Defining the simulation area and projection centre point,

2. creation of navigation points, airports, ...;

3. creating ATC Centres,

4. building volumes and consequentially sectors, assigning ATC centres,

5. edit Architecture domain,

6. create other items of airspace,

7. create flights and their paths,

8. follow the emerged errors and complete the things that are missing.

9. check, deliver, batch process (see below),

10. use run_escape on Ground, then Run Selection Tool,

11. run the exercise, analyse if everything is as intended,

12. iterate these steps if needed until the exercise is working correctly.
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A.2.5 Check, Deliver, Batch

The ‘Check, Deliver, Batch’ process is the most important process for successful exercise

creation. It consists of three separate consecutive actions that are used to

1. check the exercise for any errors or wrong data relations,

2. deliver the complete data from IPAS machine to Ground machine – for generating

the data to run an exercise correctly, and

3. batch the aircraft data (prepare their profiles).

Apart from being used individually for various reasons, the 1, 2, 3 action succession

ensures the run escape tool (see below) can be used later and the particular exercise run.

1. CHECK

i. Make sure the correct desired exercise in the IPAS supervision context area is

selected.

ii. Click the CHECK button.

iii. Select Check → Current exercise.

iv. The exercise will be checked for errors. If the respective record in the list

of EXERCISES window says the Check result is OK, and the Report panel

window says NO ERRORS DETECTED, everything is correct and both the

windows can be closed by Close button. If not, corrections have to be made to

the exercise database and the process rerun.

2. DELIVER

i. In the CHECK window, select Deliver → Current exercise.

ii. After completion, the Report panel should report that the generation of all the

files is done.

iii. All the windows except for the IPAS Supervision may be closed.

3. BATCH
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i. Click the PVT button to open the Profile Validation Tool (the window is named

Air & Ground Preparation HMI).

ii. Select Application → Analyse data with PVT → Batch (Ground only).

iii. In the PVT window, click Start button at the bottom.

iv. After a while, there should be a pop-up window with the ‘IPAS data files

updated’ message. Click OK.

v. Click OK again and close the Air & Ground Preparation HMI window.

A.3 Using ‘run escape’ Tool

As the main procedure used in this tool, exercise installation will now be described. The

tool was covered in chapter 3.1.1.

1. On the Ground Machine, open the terminal and start run_escape -u uni com-

mand. Window named ‘AcePlatform_runesc2016A’ should open.

2. Choose option 1 (ESCAPE Delivery/Installation Menu) by typing the number one

on the keyboard and hitting Enter. Similarly, next steps are carried out:

3. Choose option 1 (Configuration Parameters Menu).

4. Choose option 2 (Exercise Menu).

5. Choose option 1 (Create (and Prepare)).

6. From the list, choose your desired exercise by typing its name in precisely. If the

exercise is not listed, it has not been correctly delivered inside of IPAS. Press Enter.

7. The tool asks if you agree with the exercise creation. From there, either Enter key

can be pressed again to confirm, or n typed in to cancel (proceed again from step

5).

8. A number of lines of code will log in the window. Just check it says Exercise

compilation result:0 somewhere on the last few lines of the code. If it does, it

is completed successfully.

9. Press Enter to continue and then you can exit by x.
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A.4 Using Run Selection Tool

A.4.1 Creating a Run

Carried out in the launch_spv environment, creating a new run of an exercise enables user

to choose the desired machines to run the exercise. In other words, in bigger platforms

containing multiple CWP and/or PWP machines, it can be chosen which to run the

exercise on. It is highly dependent on the settings inside of the exercise Architecture

domain in IPAS, and ORGanization and layout settings on Ground Machine.

1. Complete the Starting the Simulator section (A.1).

2. On the Ground machine, open terminal and type in the following command:

launch_spv -u uni

3. Press Enter. The Run Selection Tool will open.

4. Choose the simulation and exercise you want to create a Run of.

5. Click ‘Create/Edit Run...’ button.

Everything should be correctly set by default in the following window, apart from the

AIR and CWP Selection. These need to be assigned to the correct machines of the used

platform.

6. Click AIR Selection

7. In AIR components tab, everything should be set – the ground machine (empgrd01

by default) should be set as supervisor, exercise manager and flight sets manager.

8. In the PWP components tab, check the box and assign a pilot position machine to

the PWP. By default and with having only one PWP, this should be emppil01. You

can see this tab opened in picture A.2a.

9. Click Save.

10. Open CWP Selection. That is picture A.2b.
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(a) PWP Components section of AIR Selection

(b) CWP Selection

Figure A.2: Selection of CWP and PWP components inside of Create/Edit Run tool (source:

author’s screenshot of the simulator)
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11. There are the numbers of controller positions – CWP 01 (the executive controller)

and CWP 31 (the feed hybrid position). Check both boxes and choose the appro-

priate machines to the positions. That would normally be empcwp01 for position 1

and empgrd01 for position 31.

12. Click Save.

13. Click Save again in the ‘Create/Edit’ run window.

14. Choose AutoConnect – this will automatically assign all the functions to the correct

places. All the components should turn green after the button is pressed.

15. Click Save again and then enter the name of the Run in the ‘Run to save’ field.

Click OK.

A.4.2 Starting an Exercise

The launch_spv component is a crucial part of Ground Machine that enables running

the Run Selection Tool that is used to start an exercise. Except the installation of a

run (which is done by run_escape in Appendix A.3), it basically manages the whole

set of supervision functions. If the desired exercise is not in the list of the Run Selec-

tion Tool, the delivery from IPAS and using run_escape tool probably was not performed.

How to start an exercise:

1. Complete the Starting the Simulator section (A.1)

2. On the Ground machine, open terminal and type in the following command:

launch_spv -u uni

3. Press Enter. The Run Selection Tool will open.

4. Choose your desired simulation (probably UNISCAPE), then Exercise and the Run.

5. Press Start.6

6On specific occasions, like a modification or recent installation (A.3) of the Run or Exercise, it is

needed to choose Light Deployment & Start in Start Mode section on the bottom right of the window. If

you modified the machines (number, IP adresses, ...), choose Full Deployment.
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A.5 Accessing the Logs and Recordings

In order to analyse the data from a carried out exercise, the user can access the logs and

recordings of the exercise, if the saving of the exercise logs and recordings was executed.

The saving is done at the end of an exercise. The programme asks the user after the Exit

button on the ground machine’s supervisor window is pressed.

(a) After clicking Exit and confirming the end of exercise, click Yes to save logs.

(b) Then it is possible to also save recordings.

Figure A.3: Saving logs and recordings (source: author’s screenshot of the simulator)
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If this prerequisite is done, the user needs to carry out following commands in terminal,

inside of Ground machine:

1) cd /exercises/bach/UNISCAPE/escape/SAT

2) ./sat.sh

The STORIA Analysis Tool (SAT) is then launched. Now the logs/recordings files

needs to be loaded by clicking File → Open. Then the following path should be ac-

cessed inside of the ‘Choose a replay file’ window and one of xml files chosen there:

/exercises/bach/<SIMULATION_NAME>/recording/grounf/<EXERCISE>_<DATE>_<TIME>
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Appendix B Administrative Tasks – Brief User’s Guide

B.1 Switching to GNOME or Back

Switching the CWP or PWP to GNOME is used when the user wants to have greater

control of the familiar UI of the machine for some time. Generally, this situation does not

happen very often, but some difficult actions in the terminal could be done easier in the

GNOME interface. Remember, it is always necessary to return back to EONS as that is

the state the simulator works properly. The Ground and IPAS machines should not be

changed into EONS.

1. Open terminal (if in GNOME), or write into the console (if in EONS).

2. Enter the superuser mode by executing command:

su

3. Enter the password.

4. Navigate to init folder by executing:

cd /etc/init

5. Precisely input and execute the required command out of the following two: (Note

that if not correctly typed in, the machine can break down and not run the system

after reboot.)

(a) For changing GNOME into EONS:

ln -sf /etc/prefdm.conf-eons prefdm.conf

(b) For changing EONS into GNOME:

ln -sf /etc/prefdm.conf-gnome prefdm.conf

B.2 Changing the Keyboard Language

As typing in the terminal can be stressful with English keyboard, it is possible to change it

to a keyboard of the user’s preference. If in EONS, that is simply done by system-config-keyboard

command run, and choosing the desired language. In GNOME, this problem is quite easy

to solve, too:
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1. Navigate to System → Preferences → Keyboard.

2. Access the Layouts tab in the Keyboard Preferences window.

3. Click Add... button and choose the desired keyboard/language. Then click Add.

4. Set the desired Language as default by clicking the circle in the list, next to the

desired record. Click the Close button.

B.3 Changing the Number of Machines in the Platform

Note that if you use a prepared VirtualBox image, you will need to change the IP of the

machine, the HW ADDRESS and hostname. Then you need to update all the files in

table 3.1. Then it is necessary to adjust the SimulationResources files in GND machine.

B.4 Backup and Restore

The platform and the data can be easily backed up and restored. If any element of

the simulator were to break completely, there is a fairly simple scenario of restoring the

machine. That being said, it requires to back up frequently.

B.4.1 The Machines

The machines can be backed up as a whole in the VirtualBox software.

1. Select a machine inside of the VirtualBox window and make sure it is not running.

2. At the top of the VirtualBox window, click Machine → Export to OCI...

3. From Format drop-down menu, select Open Virtualization Format 2.0.

4. From MAC Address Policy drop-down menu, select Include all network adapter

MAC addresses.

5. In the File section, choose the desired save location.

6. Click Next.
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7. In the next window, it is possible to set some metadata, but it can be left out and

clicked Export.

Note that the files are substantially large in size, so it is not recommended to do the

backup frequently. For example, concerning CWP and PWP machines, only one backup

is necessary, as there is nothing changing over time. Most important is the IPAS, but the

probability of the whole machine breaking is tiny.

The machines can be restored as a whole in the VirtualBox software, too.

1. At the top of the VirtualBox window, chose File → Import Appliance...

2. Choose the path of the desired .ova file of the backed-up machine.

3. Click Next.

4. From MAC Address Policy drop-down menu, select Include all network adapter

MAC addresses.

5. The other options may remain unchanged. Click Import.

B.4.2 IPAS Data

The IPAS data are subject to more danger than the machines themselves in terms of

suddenly breaking down the exercise by a change difficult to track or remember, or losing

a big amount of data in general. In these and similar cases, it is recommended to make a

backup after every major data input session.

For making a backup of IPAS data, meaning the database, perform this procedure:

1. On the IPAS Machine, open terminal and enter the ipas command. Press Enter to

open the IPAS window.

2. Choose Administration → Maintenance → Save simulation (in dmp file).

3. Choose the simulation to save and add a description – the description is part of the

saved file name.

127



Faculty of Transportation Sciences
Czech Technical University in Prague

4. Click OK and wait for the saving process to complete. You can see it in the terminal

window opened.

The confirmation window with the location of the saved dmp file (/home/ope/SAVED_SIMUL/UNISCAPE/)

is shown after completion.

For restoring the data in IPAS, follow this course of action:

1. On the IPAS Machine, open terminal and enter the ipas command. Press Enter to

open the IPAS window.

2. Choose Administration → Maintenance → Reload simulation (from dmp file).

3. From the ‘Simulation to replace’ drop-down menu, choose which current simulation

will be replaced by the restored data.

4. Import the dmp file by clicking the Browse button.

5. Wait for the restoring to finish.
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Appendix C Troubleshooting – Brief ‘Survival Kit’

C.1 Blue IPAS (Read-Only)

Only one session of IPAS can be run at the same time. IPAS is sometimes prone to

bugs, unexpected crashes or stuck windows, as any other software. This means it is then

incorrectly closed. After running IPAS again, the first session is still active in the logs

of the system. This causes IPAS to run in read-only mode, which is signified with blue

background of IPAS supervision window instead of grey one.

In order to run IPAS correctly, the active session needs to by deleted from the log. For

that matter, there is a log file that needs to be edited. For simplification, a link to this

file has been placed to Desktop in order to be easily found.

• Open (double click) the file on the Desktop named ‘blue IPAS’.

(originally, the name of the file is ipas_fic_user_nesu and is located in

/home/ope/IPAS/ACE2016A/IPAS/tmp/ on the IPAS machine)

• Click Display in the pop-up window, so that the file opens in text editor.

• Locate a line that does not begin with # character, and does end with ‘N’.

• Delete this line and save the file.

• IPAS now should start in normal mode, when it is run through ipas command.

C.2 Exercise Cannot Be Run

When the exercise cannot be successfully run, the Ground machine usually shows an error

window. There are several things that could potentially be wrong. Below, there is a list

of actions a user can try in this order. After each of the item performed, the exercise start

should be tried again.
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(a) Exit the exercise (and IPAS, if run), restart all of the machines.

(b) Make sure all the machines that need to be run are running.

(c) Make sure the exercise was correctly delivered or deployed. Use the Check, Deliver,

Batch procedure, run_escape tool to deliver the exercise again, and choose Light

Deployment as Start Mode inside of the Run Selection Tool.

(d) On Ground machine, when the exercise is not running or trying to be run, delete all

the files named token_<number> in /home/runesc/token_server/ folder. There

should ideally not be any tokens present when the exercise is not running.

(e) Correctly stop the exercise, IPAS and the VirtualBox machines and restart Windows

computers.
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